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Printer Parts and Functions

Unpacking the Printer

Your printer box should include a CD-ROM containing printer
software that runs your printer and the items shown in the
illustration.

In some locations, the power cord comes attached to the printer.
The shape of the AC plug varies by country; be sure the plug
included is the right shape for your location.

Remove all protective materials packed with your printer before
setting up and plugging in the printer. Follow the instructions
included with the printer to remove these materials. Save all
packaging and protective materials for transporting the printer in
the future.

paper support

power cord

ink cartridges

printer
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Printer Parts and Control Panel Functions

Printer parts

Paper support: Supports the paper loaded in the sheet feeder.

Edge guides: Help load the paper straight. Adjust the left edge
guide to fit the width of your paper.

Printer cover: Covers the printing mechanism. Open only when
installing or replacing ink cartridges.

Sheet feeder: Holds the blank paper and automatically feeds the
paper during printing.

Output tray: Receives the ejected paper.

sheet feeder

edge guides printer cover

paper support

output tray

output tray
extension
Printer Parts and Functions 2



 

Output tray extension: Supports the ejected paper.

Ink cartridge clamps: Hold the ink cartridges in place. Open only
when installing or replacing ink cartridges.

Print head: Delivers ink to the page.

Control panel: Controls various printer functions. See the next
section for details.

Buttons

Button Function

P

power

Turns the printer on and off.

Clears the printer's memory if pressed twice while the
power is on.

ink cartridge clamps

print head

control panel
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Lights

b

maintenance

Loads or ejects paper if pressed and released within
three seconds.

Resumes printing if pressed and released after a paper
out error.

Performs print head cleaning if pressed for
three seconds when the b error light is off.

Moves the print head to the ink cartridge replacement
position when ink is out.

e

ink cartridge
replacement

Moves the print head to the ink cartridge replacement
position and charges ink to the printer.

Light Description

P

power

On when the printer is on.

Flashing when printer is receiving data, printing,
replacing an ink cartridge, charging ink, or cleaning the
print head.

b

error

On when the printer is out of paper. Load paper in the
sheet feeder, then press the b maintenance button to
resume printing.

On when the paper is jammed. Take all of the paper out
of the feeder, then reload the paper. If the light
continues to flash, turn off the printer and gently pull all
of the paper out of the printer.

Flashing when the black or color ink cartridge is nearly
empty.

On when the black or color ink cartridge is empty.
Replace the black ink cartridge (T026) or color ink
cartridge (T027).

Flashing when the print head moves to the ink cartridge
replacement position. The light will flash faster if the color
ink is out than if the black ink is out.
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using your
printer. Also, be sure to follow all warnings and instructions
marked on the printer.

When setting up your printer

Observe the following when setting up the printer:

❏ Do not block or cover the openings in the printer’s cabinet.

❏ Use only the type of power source indicated on the printer’s
label.

❏ Be sure your AC power cord meets the relevant local safety
standards.

❏ Connect all equipment to properly grounded power outlets.
Avoid using outlets on the same circuit as photocopiers or air
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or
automatic timers.

❏ Keep the entire computer system away from potential sources
of electromagnetic interference, such as loudspeakers or the
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.
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❏ If you use an extension cord with the printer, make sure that
the total ampere rating of the devices plugged into the
extension cord does not exceed the cord’s ampere rating. Also,
make sure that the total ampere rating of all devices plugged
into the wall outlet does not exceed the wall outlet’s ampere
rating.

❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the
printer; the printer has been dropped or the cabinet damaged;
the printer does not operate normally or exhibits a distinct
change in performance.

❏ If you plan to use the printer in Germany, the building
installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and
over-current protection for this printer.

Note for German-speaking users:
Bei Anschluss des Druckers an die Stromversorgung muss
sichergestellt werden, dass die Gebäudeinstallation mit einer
10 A- oder 16 A-Sicherung abgesichert ist.

When choosing a place for the printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond
the printer base in all directions. If you place the printer by
the wall, leave more than 10 cm between the back of the
printer and the wall. The printer will not operate properly if
it is tilted or at an angle.
6



❏ When storing or transporting the printer, do not tilt it or put
it vertically or turn it upside down. Otherwise ink may leak
from the cartridge.

❏ Leave enough space in front of the printer for the paper to be
fully ejected.

❏ Avoid places subject to rapid changes in temperature and
humidity. Also, keep the printer away from direct sunlight,
strong light, or heat sources.

❏ Avoid places subject to dust, shocks, and vibrations.

❏ Leave enough room around the printer to allow for sufficient
ventilation.

❏ Place the printer near a wall outlet where the plug can be
easily unplugged.

Note for French-speaking users:
Placez l’imprimante près d’une prise de contacte où la fiche
peut être débranchée facilement.

When using the printer

Observe the following when using the printer:

❏ Do not insert objects through the slots in the printer’s cabinet.

❏ Take care not to spill liquid on the printer.

❏ Do not put your hand inside the printer or touch the ink
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may
damage the printer.
7



   
❏ Always turn the printer off using the P power button. When
this button is pressed, the P power light flashes. Do not
unplug the printer or turn off the power to the outlet until the
P power light stops flashing.

❏ Before transporting the printer, make sure that the print head
is in the home (far right) position and the ink cartridges are
in place.

❏ Leave the ink cartridges installed. Removing the cartridges
can dehydrate the printer head and may prevent the printer
from printing.

When handling the ink cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow
children to drink from or otherwise handle the cartridges.

❏ Do not shake an ink cartridge; this can cause leakage.

❏ Be careful when you handle used ink cartridges, as there may
be some ink remaining around the ink supply port. If ink gets
on your skin, wash the area thoroughly with soap and water.
If ink gets into your eyes, flush them immediately with water.
If discomfort or vision problems remain after a thorough
flushing, see a doctor immediately.

❏ Install the ink cartridge immediately after you remove it from
its package. Leaving the cartridge unpacked for a long time
before use may result in reduced print quality.

❏ Do not use an ink cartridge beyond the date printed on the
cartridge carton. For best results, use up the ink cartridges
within six months of installing them.
8



❏ Do not dismantle the ink cartridges or try to refill them. This
could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site,
allow it to warm up at room temperature for at least three
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Each time the cartridge is inserted, some ink is consumed
because the printer automatically performs a reliability check.

❏ Do not touch the green IC chip on the side of the cartridge.
This may affect normal operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge
related-information, such as the amount of ink remaining, so
that a cartridge may be removed and reinserted freely.
However, each time the cartridge is inserted, some ink is
consumed because the printer automatically performs a
reliability check.

❏ If you remove an ink cartridge for later use, protect the ink
supply area from dirt and dust and store it in the same
environment as the printer. A valve in the ink supply port
makes covers or plugs unnecessary, but the ink may stain
items that come in contact with this area of the cartridge. Do
not touch the ink supply port or surrounding area.

ENERGY STAR® Compliance

As an ENERGY STAR® Partner, EPSON has
determined that this product meets the
ENERGY STAR® guidelines for energy
efficiency.
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The International ENERGY STAR® Office Equipment Program is
a voluntary partnership with the computer and office equipment
industry to promote the introduction of energy-efficient personal
computers, monitors, printers, fax machines, copiers, and
scanners in an effort to reduce air pollution caused by power
generation.

Information for United Kingdom Users

Use of options

EPSON (UK) Limited shall not be liable against any damages or
problems arising from the use of any options or consumable
products other than those designated as Original EPSON
Products or EPSON Approved Products by EPSON (UK) Limited.

Safety information

w Warning:
This appliance must be earthed. Refer to the rating plate for the
voltage and check that the appliance voltage corresponds to the
supply voltage.

Important:The wires in the mains lead fitted to this appliance
are coloured in accordance with the following code:

Green and yellow — Earth
Blue — Neutral
Brown — Live

If you have to fit a plug:
As the colours of the mains lead of this appliance may not match
the coloured markings used to identify the terminals in a plug,
please observe the following:
10



   
❏ The green and yellow wire must be connected to the terminal
in the plug which is marked with the letter E or the earth
symbol (G).

❏ The blue wire must be connected to the terminal in the plug
marked with the letter N.

❏ The brown wire must be connected to the terminal in the plug
marked with the letter L.

❏ If the plug is damaged, replace the cord set or consult a
qualified electrician.

❏ Replace fuses only with fuses of the correct size and rating.

Warnings, Cautions, and Notes

w Warnings
must be followed carefully to avoid bodily injury.

c Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your
printer.
11
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Chapter 1

Printing Basics

For Windows Users

Step 1. Choosing the data to print

Choose an A4-size data to print. Any data, such as photo or text,
is OK.

Step 2. Preparing and loading paper

After choosing the data, prepare the A4-size plain paper and load
them into the printer.

To load the paper, follow the instructions below.

1. Lower the output tray and slide out the extension. Next, hold
down the tab on the left edge guide and slide the guide so that
the distance between the edge guides is slightly wider than
the width of your paper.

2. Fan a stack of paper, and then tap it on a flat surface to even
the edges.
Printing Basics 12



3. Load the stack of paper in the sheet feeder with the printable
side up and the right edge of the paper resting against the
right edge guide. Then, slide the left edge guide against the
left edge of the paper. Make sure that the paper stack is loaded
under the tabs inside the edge guides.

Step 3. Making the printer driver settings

To select the printer driver settings for A4-size plain paper, follow
the instructions below.

1. Choose Print or Print Setup on the File menu of the Window’s
application.

2. In the dialog box that appears, click Printer, Setup, Options,
or Properties. (Depending on your application, you may
need to click a combination of these buttons.) The printer
software opens.
13 Printing Basics
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3. Click the Main tab, and then select Plain Paper and A4 as the
Paper Options settings, and Text & Images as the Quality
Type setting.

4. Click OK to close the window.

Step 4. Printing your data

Now, print the data from your application.
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Click OK to print.

This completes the basic printing procedure. If you would like to
try advanced printing, see Various Printing Options.

For Macintosh Users

Step 1. Choosing the data to print

Choose an A4-size data to print. Any data, such as photo or text,
is OK.

Step 2. Preparing and loading paper

After choosing the data, prepare the A4-size plain paper and load
them into the printer.
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To load the paper, follow the instructions below.

1. Lower the output tray and slide out the extension. Next, hold
down the tab on the left edge guide and slide the guide so that
the distance between the edge guides is slightly wider than
the width of your paper.

2. Fan a stack of paper, and then tap it on a flat surface to even
the edges.

3. Load the stack of paper in the sheet feeder with the printable
side up and the right edge of the paper resting against the
right edge guide. Then, slide the left edge guide against the
left edge of the paper. Make sure that the paper stack is loaded
under the tabs inside the edge guides.

Step 3. Making the printer driver settings

To select the printer driver settings for A4-size plain paper, follow
the instructions below.

For users of Mac OS 8.1 or later (except Mac OS X)

1. Click Page Setup on the File menu of your application.
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2. Select A4 as the Paper Size setting. Then, click OK to close the
dialog box.

3. Click Print on the File menu of your application.

4. Select Plain Paper as the Media Type setting, and Automatic
as the Mode setting.

For Mac OS X users

1. Click Page Setup on the File menu of your application.
17 Printing Basics
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2. Select A4 as the Paper Size setting. Then, click OK to close the
dialog box.

3. Click Print on the File menu of your application.

4. Select Print Settings from the pop-up menu in the Print
dialog box.

5. Select Plain Paper as the Media Type setting, and Automatic
as the Mode setting.
Printing Basics 18



Step 4. Printing your data

Now, print the data from your application.

Click Print in the Print dialog box to start printing.

This completes the basic printing procedure. If you would like to
try using advanced printing settings, see Various Printing
Options.
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Chapter 2

Various Printing Options

Introduction

This printer provides you with a variety of different printing
options. You can print in various formats, or can print using many
different types of paper.

The following explains the procedure for each type of printing.
Choose the appropriate one for your printing.

Borderless Printing

Lets you print with no margin on all four sides of the paper.
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“Fit to Page Printing” on page 27

Lets you automatically enlarge or reduce the size of your
document to fit the paper size you selected.

Pages Per Sheet Printing (Windows), N-up Printing (Macintosh)

Lets you print 2 or 4 pages on a single sheet.

Poster Printing

Lets you enlarge a single document page to cover 4, 9, or 16
printed sheets of paper and put them together to make a poster.
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Watermark Printing

Lets you print a text or image as a watermark on your printout.

For example, you can put "Confidential" on an important
document.

Printing on Single Sheets

Lets you print on various sizes or kinds of single sheet paper.
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Printing on Envelopes

Lets you print on envelopes.

Borderless Printing

This printer allows you to print with no margin on all four sides
of the paper. Follow the steps below to print with no margins.
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Note:
This feature is not available with Mac OS X.

Notice that not all kinds of paper are available for this option.

Available paper

You can use this option with single sheets of the paper types listed
below.

EPSON Photo Quality Ink Jet Paper
EPSON Photo Paper
EPSON Matte Paper-Heavyweight
EPSON Premium Glossy Photo Paper

You cannot use this feature with ColorLife Photo Paper, Photo
Quality Glossy Film, Ink Jet Transparencies, Iron-On Cool Peel
Transfer Paper or 360 dpi Ink Jet Paper. If you use other media,
your printout will be blurry or smeared.

Printing data

Because this option enlarges the image to a size slightly larger
than the paper size, the portion of the image that extends beyond
the edges of the paper will not be printed.

When creating your printing data using an application, note the
following:

Printing on single sheet

You need to fit your data to the size of paper. If your application
has margin settings, make sure they are set to zero before printing.
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Paper loading

After you select a media on which to print, load it onto your
printer. Refer to the appropriate section below for your chosen
media.

Single Sheets

Driver settings

After you load the media, change the settings on your printer
driver to the no-margin option.

1. Access the printer driver.

Accessing the Printer Software for Windows

Accessing the Printer Software for Macintosh

2. For Windows, select the desired Type and Size settings under
Paper Options setting on the Main menu and select the
Borderless check box.
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Media Type Settings

For Macintosh, select the Paper Size that you want to use on
the Page Setup dialog box and select the No Margins check
box, and then select the desired Media Type on the Print
dialog box.
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Media Type Settings

3. Click OK to close the driver setting dialog.

Printing

After finishing all above steps, start printing.

We recommend you to print once as a test before printing large
quantities.

Fit to Page Printing
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You can print using Fit to page printing function, when, for
example, you want to print a document that you made as A4 size
on another size paper.

You can print using Fit to page printing to fit the paper size you
selected in the paper Size list on the Paper menu.

Note:
This feature is not available with Mac OS X.

Paper loading

Load paper in your printer.

Loading single sheets

Driver settings

1. Access the printer driver.

Accessing the Printer Software for Windows

Accessing the Printer Software for Macintosh

2. Select the desired Type setting under Paper Options on the
Main menu (Windows).

Select the desired Media Type on the Print dialog box
(Macintosh).

Media Type Settings

3. Under Paper Options on the Main menu (Windows), select
the desired Size setting for the original print data.
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On the Page Setup dialog box (Macintosh), select the desired
Paper Size for the original print data.

4. On the Page Layout menu (Windows), select the
Reduce/Enlarge Document check box and select the By 
Output Paper Size option.
29 Various Printing Options



2

2

2

2

2

2

2

2

2

2

2

2

Select Fit to Page check box on the Layout dialog box
(Macintosh).

5. Under By Output Paper Size on the Page Layout menu
(Windows), select the paper size that you loaded in your
printer.

Under Output Paper Size on the Layout dialog box
(Macintosh), select the paper size that you loaded in your
printer.
Various Printing Options 30



6. Click OK to close the printer driver setting dialog.

Printing

After finishing all above steps, start printing.

Pages Per Sheet Printing (Windows), N-up
Printing (Macintosh)

Pages Per Sheet Printing (Windows) or N-up printing
(Macintosh) allows you to print two or four pages on single sheets
of paper.

Paper loading

Load paper in your printer.

“Loading single sheets” on page 131

Driver settings

1. Access the printer driver.

“Accessing the Printer Software for Windows” on page 140
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“Accessing the Printer Software for Macintosh” on page 141

2. Select the desired Type setting under Paper Options on the
Main menu (Windows).

Select the desired Media Type on the Print dialog box
(Macintosh).

“Media Type Settings” on page 143

3. Under Paper Options on the Main menu (Windows), select
the Size setting for the original print data.

On the Page Setup dialog box (Macintosh), select the Paper 
Size setting for the original print data.

4. For Windows, select the Pages Per Sheet option under
Multi-Page on the Page Layout menu, and then click the up
or down arrow to select a number from 2 or 4.
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For Macintosh, select the Multi-Page check box on the Layout
dialog box, and then select N-up.

5. Make the following settings for Pages Per Sheet Printing
(Windows) or N-up printing (Macintosh).

2, 4
(Windows)
2 Pages, 4 Pages
(Macintosh)

Prints two or four pages of your document on a
single piece of paper.

Page Order
(Windows)

Opens the Print Layout dialog box, where you
can specify the order in which the pages will be
printed. Some settings may be unavailable,
depending upon the Orientation selection on
the Main menu.

Page Order
(Macintosh)

Allows you to specify the order in which the
pages will be printed on the sheet of paper.
Some settings may be unavailable, depending
upon the Orientation selection in the Page
Setup dialog box.

Print Page Borders
(Windows)
Print page frames
(Macintosh)

Prints frames around the pages printed on each
sheet.
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For Mac OS X users

Select Layout from the pop-up menu as the Multi-Page setting to
print multiple pages of your document on one sheet of paper.

When Layout is selected, you can make the following settings:

6. Click OK to close the driver setting dialog.

Note:
The Layout settings available are a standard feature of Mac OS X.

Printing

After finishing all above steps, start printing.

Pages per Sheet Prints a multiple pages of your document on a
single piece of paper. You can select from 1, 2,
4, 6, 9, or 16.

Layout Direction Allows you to specify the order in which the
pages will be printed on the sheet of paper.

Border Prints a border around the pages printed on
each sheet. You can select from None, Single
hairline, Single thin line, Double hairline, or
Double thin line.
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Poster Printing

Poster printing allows you to print poster-size images by
enlarging one page to cover several sheets of paper.

Note:
This feature is not available with Mac OS X.

Paper loading

Load paper in your printer.

“Loading single sheets” on page 131

Driver settings

For Windows users

1. Access the printer driver.

“Accessing the Printer Software for Windows” on page 140

2. Select the desired Type setting under Paper Options on the
Main menu.

“Media Type Settings” on page 143
35 Various Printing Options



2

2

2

2

2

2

2

2

2

2

2

2

3. Under Paper Options on the Main menu, select the Size
setting for the original print data.

4. Select the Poster Printing option under Multi-Page on the
Page Layout menu, and then click the up or down arrow to
select 2x2, 3x3 or 4x4.
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5. Click the Settings button to adjust the way your poster will
print. The Poster Settings dialog box opens.

6. Make the following settings for poster printing.

Print Cutting
Guides

Select this check box to turn the cutting guide
options on.

Overlapping
Alignment Marks

Slightly overlaps the images and prints alignment
markers so that they can be aligned more precisely.

Trim Lines Prints border lines on the images to guide you when
trimming the pages.
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Note:
If you only want to print a few of the panels without printing the
entire poster, click the panels that you do not wish to print.

7. Click OK to close the Poster Settings dialog box.

For Macintosh users

1. Access the printer driver.

“Accessing the Printer Software for Macintosh” on page 141

2. On the Page Setup dialog box, select the Paper Size for the
original print data.

3. Select the desired Media Type setting on the Print dialog box.

“Media Type Settings” on page 143

4. Select the Multi-Page check box on the Layout dialog box and
select Poster.
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5. Make the following settings for poster printing.

Note:
If you only want to print a few of the panels without printing the
entire poster, click Panel Selection, then click the panels that you
do not wish to print, and then click OK.

6. Click OK to close the Layout dialog box.

Printing

After finishing all above steps, start printing.

1 page covers xx sheets Specifies how many printed sheets of paper
the enlarged document page is to cover. You
can select 4, 9, or 16 sheets.

Overlapping Alignment
Marks

Slightly overlaps the images and prints
alignment markers so that they can be
aligned more precisely.

Trim Lines Prints border lines on the images to guide you
when trimming the pages.

Panel Selection Click the Panels you do not need to print, then
click the OK button to print the remaining
panels.
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Watermark Printing

Watermark printing allows you to print a text-based or an
image-based watermark on your document.

Note:
This feature is not available with Mac OS X.

Printing the watermark

1. Load paper in the printer.

“Single Sheets” on page 131

2. Access the printer driver software.

“Accessing the Printer Software for Windows” on page 140

“Accessing the Printer Software for Macintosh” on page 141

3. For Windows, select the desired Size and Type settings under
Paper Options on the Main menu.
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For Macintosh, select the desired Media Type on the Print
dialog box, and then select the desired Paper size setting on
the Page Setup dialog box.

“Media Type Settings” on page 143

4. For Windows, select the desired watermark from the
Watermark list on the Page Layout menu, and then click
Settings.
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For Macintosh, select the Watermark check box in the Layout
dialog box, and then select the desired watermark from the
Name list.
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5. Specify the necessary settings for the watermark. You can
change the position and size of the watermark by dragging it
within the preview window at the left.

6. Click OK to close the driver settings dialog box.

7. Print the data from your application.
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Creating your own watermark

You can add your own text-based or image-based watermarks to
the watermark list.

For Windows

1. Click Add/Del on the Page Layout menu. The following dialog
box appears.

2. To use an image file as a watermark, select BMP. Click
Browse to specify the bitmap file you want to use, and then
click OK. Type a name for your watermark in the Name text
box, and then click Save.

To create a text-based watermark, select Text. Type your text
in the Text text box. The text that you enter will also be used
as the watermark name. If you want to change the watermark
name, type a new name in the Name text box, and then click
Save.
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3. Click OK to return to the Layout menu.

For Macintosh

1. Click Add/Del beside the Name list. The following dialog box
appears.

2. To use an image file as a watermark, click Add PICT. Specify
the desired image file, and then click Open.
45 Various Printing Options



2

2

2

2

2

2

2

2

2

2

2

2

To create a text-based watermark, click Add Text. Type the
text in the Text text box, select a font and a text style, and then
click OK.

3. The image file name or the watermark text appears in the
Mark Name list in the Watermark dialog box. To change the
name of an image watermark, select it from the list, and then
type a new name. When a text watermark is selected in the
Name list, you can edit the text or change the font and text
style by clicking Edit Text.

4. Click OK to add your watermark to the Name list in the
Layout dialog box.
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Printing on Single Sheets

Handling single sheets

Refer to the section mentioned below for details on loading single
sheets.

Single Sheets

When using special media, refer to the section mentioned below.

Single Sheets

Printing on single sheets

1. Access the Printer driver.

Accessing the Printer Software for Windows

Accessing the Printer Software for Macintosh

2. For Windows, select the desired Size and Type settings under
Paper Options on the Main menu.
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Media Type Settings

For Macintosh, select the desired Media Type on the Print
Dialog box, and then select the desired Paper size setting on
the Page Setup Dialog box.

Media Type Settings
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3. Select Portrait (tall) or Landscape (wide) to change the
orientation of your printout.

4. Click OK to close the driver settings dialog box.

5. Print your data.

Printing on Envelopes

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes at a time in the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the
total thickness of the stack of envelopes exceeds 10 mm, press each
envelope in the stack flat before loading. If print quality declines
when a stack of envelopes is loaded, load one envelope at a time.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope flaps before loading.
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❏ Avoid using envelopes that are too thin as they may curl
during printing.

❏ EPSON recommends the use of black ink when printing on
envelopes. Should you decide to use another color of ink, set
a wider margin in order to prevent ink from smearing across
the bottom portion of the envelope.

❏ The printable area specified below is recommended when
printing in black ink.

A: The minimum top margin is 3.0 mm (0.12").

When loading multiple sheets of EPSON Photo
Quality Glossy Film, the minimum top margin is
30.0 mm (1.2").

B-L: The minimum left margin is 3.0 mm (0.12").

B-R: The minimum right margin is as follows:
3.0 mm (0.12") for single sheets and C6 envelopes.
7.0 mm (0.28") for DL envelopes.
28.0 mm (1.10") for No. 10 envelopes.

C: The minimum bottom margin is 14.0 mm (0.55").

A

B-L B-R

C
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Loading envelopes

Refer to the section below.

Envelopes

Printing on envelopes

1. Access the printer driver.

Accessing the Printer Software for Windows

Accessing the Printer Software for Macintosh

2. Select Plain Paper as the Type setting on the Main menu
(Windows) or the Media Type setting in the Print dialog box
(Macintosh).

3. Select the appropriate envelope size from the available Size
settings on the Main menu (Windows) or the Paper Size
settings in the Page Setup dialog box (Macintosh).

4. Select Portrait as the Orientation setting.

5. Click OK to close the driver settings dialog box.

✽: You can extend the minimum bottom margin to
3 mm by selecting the Minimize Margins check box
under More Options on the printer driver's Page
Layout menu (Windows) or the Maximum option
for Printable Area in the Page Setup dialog box
(Macintosh). However, print quality may decline in
the expanded area. Before printing large jobs using
this setting, print a single sheet to confirm printout
quality.
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6. Print your data.
Various Printing Options 52



Chapter 3

Printer Software Functions

For Windows Users

Printer Software Introduction

The printer software which comes with your printer includes a
printer driver and printer utilities. The printer driver lets you
choose from a wide variety of settings to get the best results from
your printer. The printer utilities help you check the printer and
keep it in top operating condition.

The printer driver settings and utilities are on the printer software
menus shown below.

If you encounter any problems when using the printer software,
refer to the Problem Solver HTML manual for help by clicking
Technical Support on the Main menu of the printer software.

Menu Settings and Utilities

Main Quality Type, Paper Options, Print Options, Ink Levels,
Orientation, Advanced

Page Layout More Options, Reduce/Enlarge Document, Copies,
Multi-Page, Watermark

Maintenance EPSON Status Monitor 3, Nozzle Check, Head Cleaning,
Print Head Alignment, Printer and Option Information,
Speed & Progress
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Getting more information

For information on using the printer software, see “Making
Settings on the Main Menu” on page 55 or “Making Settings on
the Page Layout Menu” on page 69.

For information on using the printer utilities, see “Making
settings on the Maintenance Menu” on page 75.

Note:
The specific features available in the printer software vary depending on
the version of Windows that you are using.

Online help provides more information about the printer
software. See “Getting Information Through Online Help” on
page 83 for instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows
applications, from the Windows Start menu or taskbar.

When you access the printer software from a Windows
application, the settings that you make apply only to the
application you are using.

When you access the printer software from the Start menu or the
taskbar, the settings that you make apply to all of your Windows
applications.

Refer to the appropriate section below.

From Windows applications

Follow the steps below to access the printer software.

1. Click Print or Print Setup on the File menu.
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2. In the dialog box that appears, click Printer, Setup, Options,
or Properties. (Depending on your application, you may
need to click a combination of these buttons.) The printer
software opens.

From the Start menu

Follow the steps below to access the printer software.

1. For users of Windows Me, 98, 95, 2000 and NT 4.0, click Start,
point to Settings, then click Printers.
For Windows XP users, click Start, Control Panel, Printers 
and Other Hardware, then Printers and Faxes.

2. For Windows Me, 98 and 95 users, select your printer, and
click Properties on the File menu.

For Windows XP and 2000 users, select your printer, then
click Printing Preferences on the File menu.

For Windows NT 4.0 users, select your printer, then click
Document Defaults on the File menu.

The printer software opens.

From the taskbar (For Windows Me, 98,95, XP and 2000)

Right-click the printer icon on the taskbar, then select Printer 
Settings.

Making Settings on the Main Menu

You can make Quality Type, Paper Options, Print Options,
Orientation and Advanced settings and check the Ink Levels on
the Main menu. Refer to the appropriate section below.
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Making Basic settings

Quality Type

Under Quality Type on the Main menu, five levels of control over
the printer software are available.

You can select one of the following quality types.

Paper Options

Type

Select the media type that you want to use.

Draft For economical, high-speed printing.

Text For medium-quality, standard text printing.

Text &
Image

For high-quality, standard text and graphics printing.

Photo For high-quality, photographic printing.

Best Photo For top-quality, photographic printing.
Printer Software Functions 56



The Type setting determines what other settings are available, so
you should always make this setting first.

On the Main menu, select the Type setting that matches the media
that is loaded in the printer. To find out what media type you are
using, find your media in the Media Type Settings list, and refer
to the corresponding media type under which it is grouped
(shown in larger type). For some media, there are several Media
Type settings from which to choose.

Media Type Settings

Size

Select the paper size that you want to use. You can also add a
custom paper size.

Borderless

Check this box when you want to print with no margins. This
feature prints to all four edges of the paper.

You can use the following media with this feature.

Photo Quality Ink Jet Paper:
A4, Letter, 5 × 8”

Matte Paper-Heavyweight:
A4, Letter

Photo Paper:
A4, Letter, 4 × 6”, 4 × 6” (No Perforations), 100 × 150 mm, 200 ×
300 mm, 210 × 594 mm

Premium Glossy Photo Paper
5 × 7”

Note:
❏ If your application has margin settings, make sure they are set to

zero before printing.
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❏ Printing with this feature selected takes longer than for normal
printing.

❏ Because this feature enlarges the image to a size slightly larger than
the paper size when Sheet Feeder is selected as the Paper Source
setting, the portion of the image that extends beyond the edges of the
paper will not be printed.

❏ Print quality may decline in the top and bottom areas of the printout,
or the area may be smeared when printing on media other than that
listed above. We recommend printing a single sheet to check quality
before printing large jobs.

❏ You cannot use this feature with ColorLife Photo Paper, Photo
Quality Glossy Film, Ink Jet Transparencies, Iron-On Cool Peel
Transfer Paper or 360 dpi Ink Jet Paper.

Print Options

PhotoEnhance

This mode lets you choose image correction settings specially
designed for scanned or digitally captured photos.

Reverse order

Lets you print your documents in reverse order, starting with the
last page.

Print Preview

Select the Print Preview check box under Print Options when you
want to view a preview of your document before printing.
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When you send a print job to the printer, the EPSON Print
Preview window opens, allowing you to make changes before
printing.

The EPSON Print Preview toolbar contains several icon buttons
which you can use to perform the following functions.

Drag ’n’ Drop Click this button to select and move
watermarks.

Zoom Click this button to enlarge or reduce the
size of the previewed page.

Fit To Screen Click this button to scale the previewed
page so that it fits the size of the window.
This is convenient when you want to see
the entire page at one time.

Maximum
Zoom

Click this button to display the previewed
page at the maximum possible zoom
ratio.
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You can also manipulate the previewed document in the
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview window.

❏ Magnify the previewed document. To do this, click Magnify
on the View menu to open the Magnify window, which
magnifies the area of the previewed document that is outlined
by the red box. By dragging the red box, you can change which
part of the document is magnified.

Printable Area
On/Off

Click this button to display or hide the
borderlines which indicate the printable
area. The printer cannot print anything
which is outside of this area.

Watermark Click this button to open the Watermark
dialog box, where you can add
watermarks to the document and
change any of the current watermark
settings.

Reset
Watermark
Settings

Click this button to return all watermark
settings to what they were when the
EPSON Print Preview dialog box was first
opened. If no settings have been
changed, this feature is not available.

Previous Page Click this button to display the page
previous to the one currently being
previewed. If there is no previous page,
this feature is not available.

Next Page Click this button to display the next page
in the document. If there is no next page,
this feature is not available.
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❏ View the individual pages that comprise a poster. The Poster
window opens automatically when you send a print job while
Poster Printing is selected as the Multi-Page option on the
Page Layout menu. From this window, you can view the
individual pages which make up a poster. You can also open
this dialog box by clicking Poster on the View menu.

❏ Apply watermarks. The watermark that you select will be
displayed on the previewed image. For detailed information
on customizing watermarks, see “Watermark” on page 72.

❏ Specify which pages of the document you would like to print.
To add or remove a page, click the page icon in the list at the
left side of the preview window, then add or remove it using
the commands on the Print Options menu. The Print Options
commands are as follows:

After you have previewed the document, click Print to print the
document, or click Cancel to cancel printing.

Orientation

Select Portrait (tall) or Landscape (wide) to change the orientation
of your printout.

Add page Click this button to add the highlighted
pages to the list of pages to be printed.

Remove
page

Click this button to remove the
highlighted pages from the list of pages
to be printed.
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Show Settings

When you click Show Settings, the Current Setting window
appears. To hide the window, click Hide Settings or Close in the
Current Settings window.

Making Advanced settings

The settings in the Advanced dialog box give you complete
control over your printing environment. Use these settings to
experiment with new printing ideas or to fine-tune a range of
print settings to meet your individual needs. Once you are
satisfied with your new settings, you can give them a name and
add them to the Custom Settings.

Follow the instructions in this section to make Advanced settings.

Note:
❏ Advanced settings are recommended for experienced users only.

Incorrect settings can reduce print speed or quality.

❏ The printer software screens that appear in this procedure are for
Windows 98 and 95. The Windows Me, NT 4.0, XP and 2000
printer software screens differ slightly in appearance.
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1. Click Advanced on the Main menu. If the Note window as
following appears, click Continue.The Advanced menu
appears.

2. Select a Media Type setting that is appropriate for the media
loaded in the printer.

Media Type Settings
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3. Select color printing or monochrome printing. If you want
monochrome printing, select the Black Ink Only check box
under Print Options.

4. Specify a Print Quality setting under Paper & Quality
Options.

5. Make other settings as necessary. For details, see the online
help.

Note:
❏ The PhotoEnhance feature only affects images, not text or

graphs. For example, if Monochrome is selected from the Tone
list (enabled when PhotoEnhance is selected), only the images
in a document will be printed in monochrome. Any colored text
or graphs in the same document will be printed in color.

❏ Some settings may be unavailable, depending on the Media
Type, Ink, and Print Quality settings that you make.

6. Click OK to apply your settings. To cancel your settings, click
Cancel.

To save your Advanced settings as a group with a unique
name, proceed to the next section.
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Save Setting

To save your Advanced settings as a group with a unique name,
click Save Setting in the Advanced menu. The Custom Settings
dialog box appears.

Type a unique name for your settings in the Name text box, then
click Save. Your Advanced settings will be added to the Custom
Settings list.

To delete a setting from the Custom Settings list, select it in the
Custom Settings dialog box and click Delete.

To use your saved settings, click Advanced on the Main menu,
and then select your settings in the Custom Settings list.

If you change the settings while one of your customized settings
is selected in the Custom Settings list, the selection shown in the
list returns to Custom Settings. The customized setting that was
previously selected is not affected by the change. To return to your
customized setting, simply reselect it in the list.
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Paper & Quality Options

You can select media type, print quality, paper size and borderless
printing.

Note:
The availability of the Print Quality setting depends on the Media Type
setting. Therefore, select the Media Type before you set the Print Quality.

Print Options

Reverse order

Lets you print your documents in reverse order, starting with the
last page.

Minimize Margins

To increase the printable area, select Minimize Margins.

Note:
❏ Do not select Minimize Margins when using Premium Glossy

Photo Paper.

❏ When the Minimize Margins option is selected for Printable Area,
the print quality may decline at the edges of the printout. Before
printing large jobs using this setting, print a single sheet to confirm
quality.

❏ When the Minimize Margins check box under Print Options is
selected, make sure that the paper loaded in the sheet feeder is not
curled.

High Speed

This setting activates bidirectional printing so your printer prints
both left-to-right and right-to-left. High Speed mode speeds up
printing, but decreases print quality.

Black Ink Only

Check Black Ink Only to print in black and white or grayscale.
Printer Software Functions 66



Edge Smoothing

Improves the print quality of low-resolution images by
smoothing jagged edges and lines. This setting has no effect on
high-resolution images or on text.

Color Management

Color Controls

For use with the color matching and image enhancement methods
provided by the printer driver. When you select Color Controls,
additional settings appear under the Color Management options
allowing you to select a Color Mode setting and to adjust the Color
Enhancement sliders.

Gamma

To control image contrast by modifying the midtones and
mid-level grays.

Note:
This option appears only when Color Controls is selected.

PhotoEnhance

This mode provides a variety of image correction settings that you
can apply to your photos before printing. PhotoEnhance does not
affect your original data.

Note:
❏ This mode is only available when printing 16-, 24-, or 32-bit color

data.

❏ Printing with PhotoEnhance selected may increase the time
required for printing, depending on your computer system and the
amount of data contained in your image.

Tone:
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You can select from the following settings.

Effect:

You can select from the following settings.

Selecting PhotoEnhance also enables the Digital Camera 
Correction check box. Select this check box when you are printing
photos taken with a digital camera to give your printed images
the smooth, natural appearance of photographs taken with a film
camera.

ICM

This method automatically adjusts printout colors to match the
colors on your screen. ICM stands for Image Color Matching.

Normal Applies EPSON standard tone adjustment to your
document.

Hard Prints in high contrast, which sharpens the printed
image.

Vivid Intensifies the colors and lightens the midtones and
highlights of an image. Use this setting for presentation
graphics, such as charts and graphs.

Sepia Applies a sepia tone to your photos.

Monochrome Prints the image in black and white only.

None Makes no tone adjustment to your document.

Sharpness Sharpens the overall image, particularly the outlines.

Soft Focus Makes your photos look as if they were taken with a
soft-focus lens.

Canvas Makes the image look like a picture painted on canvas.

Parchment Makes the image look as if it was printed on parchment.

None Applies no effect to your document.
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Show this screen first

Shows the Advanced menu when accessing the Main menu in the
printer software. The Advanced menu also appears when
accessing the printer software from applications.

Basic

Shows the Basic menu.

Making Settings on the Page Layout Menu

More Options

Use the options in the More Options box to adjust the total area
available for printing.
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You can make the following settings as the More Options:

Reduce/Enlarge Document

Use the Reduce/Enlarge Document options to adjust the printed
size of your document.

You can select from the following settings.

Copies

Select the number of copies that you want to print.

You can select from the following settings.

Centered Prints your document at an equal distance from all
edges of the paper, directly in the center.

Minimize
Margins

Expands printable area at the bottom of the paper by
11 mm, allowing you to print up to 3 mm from the
bottom edge.

Rotate 180° Prints closer to the bottom of the page.

Mirror Image Prints an image as it would appear in a mirror. Text and
graphics appear backwards.

By Output Paper
Size

Proportionally enlarges or reduces the size of
your document to make it fit the paper size
selected in the By Output Paper Size list.

By Percentage Allows you to manually reduce or enlarge an
image. Click the arrows to select a percentage
between 10 and 400.

Reverse Order Print your documents in reverse order, starting
with the last page.

Collate Print one complete document set at a time.
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Multi-Page

Under Multi-Page you can choose between the Pages Per Sheet 
and Poster Printing options. Refer to the appropriate section
below.

Pages Per Sheet

Select the Pages Per Sheet option under the Multi-Page on the
Page Layout menu to print two or four pages of your document
on one sheet of paper.

You can make the following settings:

Poster Printing

A single document page can be enlarged to cover 4, 9, or 16
printed sheets of paper.

2, 4 Prints two or four pages of your document on a
single piece of paper.

Page Order Opens the Print Layout dialog box, where you
can specify the order in which the pages will be
printed. Some settings may be unavailable,
depending upon the Orientation selection on
the Main menu.

Print Page Borders Prints frames around the pages printed on each
sheet.
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Click the Settings button to adjust the way your poster will print.
The Poster Settings dialog box opens.

You can make the following settings.

If you only want to print a few of the panels without printing the
entire poster, click the panels that you do not wish to print, then
click OK to close the Poster Settings dialog box.

Watermark

To print a watermark on your document, click anywhere in the
Watermark list box on the Layout menu and select a watermark.

Print Cutting
Guides

Select this check box to turn the cutting guide
options on.

Overlapping
Alignment Marks

Slightly overlaps the images and prints alignment
markers so that they can be aligned more precisely.

Trim Lines Prints border lines on the images to guide you when
trimming the pages.
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You can also add your own text-based or image-based
watermarks to the Watermark list. To add a watermark, click
Add/Del. The following dialog box appears.

Refer to the appropriate section below to finish creating a custom
watermark.

Creating an image-based watermark

Follow the steps below to create an image-based watermark.

1. Select BMP.

2. Click Browse to specify the bitmap file you want to use, then
click OK.

3. Type a name for your watermark in the Name text box, then
click Save. Click OK to return to the Layout menu.

Creating a text-based watermark

Follow the steps below to create a text-based watermark.
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1. Select Text.

2. Type your text in the Text text box. The text that you enter will
also be used as the watermark name.

3. If you want to change the watermark name, type a new name
in the Name text box, then click Save. Click OK to return to
the Page Layout menu.

Adjusting the appearance of watermarks

Follow the steps below to adjust the appearance of watermarks
when printed.

1. Select a watermark in the Watermark list box.

2. Click Settings. The following dialog box appears.
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3. Make sure that the appropriate watermark is selected in the
Watermark list box, then make Color, Position, Density, Size,
Font, Font Style, and Angle settings. (For details, see online
help.) Your settings are reflected in the display at the left side
of the dialog box.

4. When you are finished making settings, click OK.

Making settings on the Maintenance Menu

EPSON printer utilities allow you to check the current printer
status and to perform some printer maintenance from your
computer.

To use the utilities, click the Maintenance tab in the printer
software, then click the button for the utility that you want to use.
For information on how to access the printer software, see
“Accessing the printer software” on page 54.
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Note:
❏ The letter in parentheses after the utility name indicates the shortcut

key for that utility. Press Alt and the letter on the keyboard to open
that utility.

❏ Do not use the Nozzle Check, Head Cleaning, or Print Head
Alignment utilities if your printer is connected to your computer
through a network.

❏ Do not use the Nozzle Check, Head Cleaning, or Print Head
Alignment utilities while printing is in progress; otherwise, your
printout may be marred.

Refer to the appropriate section below.

EPSON Status Monitor 3

Status Monitor 3 provides you with printer status information,
such as the amount of ink remaining, and checks for printer errors.

This utility is only available when both of the following conditions
are met:

❏ The printer is connected directly to the host computer via the
parallel or USB port.

❏ Your system is configured to support bidirectional
communication.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for
clogging. Check the nozzles if you notice print quality has
declined and after cleaning to confirm that the print head nozzles
have been cleared. If the nozzle check indicates the print head
needs cleaning, you can access the Head Cleaning utility directly
from the Nozzle Check utility. For details, see “Checking the Print
Head Nozzles” on page 161.
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Head Cleaning

The Head Cleaning utility cleans the print head. You may need
to clean the print head if you notice print quality has declined.
Use the Nozzle Check utility first to confirm that the print head
needs to be cleaned. You can access the Nozzle Check utility
directly from the Head Cleaning utility. For details, see “Cleaning
the Print Head” on page 164.

Print Head Alignment

The Print Head Alignment utility aligns the print head. If you
notice a misalignment of vertical lines in your printouts, use this
utility as described below to realign the print head.

When you run the Print Head Alignment utility, the printer prints
test patterns that you use to check the print head alignment.

Here are sample printouts.
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From each pattern on the printed test sheet, choose the vertical
line that is aligned best. For each pattern, select the corresponding
line number from the appropriate drop-down list box in the Print
Head Alignment dialog box, then click Finish to put the new
settings into effect.

Note:
If you cannot find a line which is aligned correctly, select the number of
the line which is the closest to being correct and click Realignment. The
lines you selected will be reset to the center (number 8) position and the
alignment test sheet will be printed again.
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Printer and option information

This utility allows the printer driver to confirm printer
configuration information. It also provides specific information
regarding certain characteristics of the printer, such as the Printer
ID.

Depending on the configuration of your system, the information
displayed in the Printer and Option Information dialog box may
be updated automatically, or may need to be entered manually.

If a message appears in the Current Settings window prompting
you to enter settings, or if you change the printer configuration,
follow the steps below to make the necessary settings manually.

1. Click Settings Sheet in the Printer and Option Information
dialog box to print out information about your printer and
options. A4 or Letter size paper must be loaded in your printer
to use this utility. You will see a printout similar to the one
below.
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2. Make sure the settings in the utility match the information on
the printed Settings Sheet. If they do not match, correct the
settings on the screen to match the information on the settings
sheet.

3. Click OK to exit this menu and save your settings.

Speed & Progress

You can make settings related to print speed and progress in this
dialog box.

The available settings are as follows:

Note:
The specific features available in the printer software vary depending on
the printer model and version of Windows that you are using.
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High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk
space as a cache when printing multiple copies of your document.

EPSON Printer Port (Windows Me, 98, 95 only)

For printer models that use the parallel port, you can speed up
the data transfer rate by selecting EPSON Printer Port.

Parallel port users can further increase print speed by enabling
DMA transfer, as explained in “Enabling DMA transfer” on page
192.

Show Progress Meter

To display the Progress Meter every time you print, select Show 
Progress Meter.

Always spool RAW datatype (for Windows XP, 2000 and NT 4.0
only)

Select this check box to have Windows NT-based clients spool
documents using the RAW format instead of the EMF (metafile)
format (Windows NT-based applications use the EMF format by
default).

Try using this option if documents spooled in EMF format do not
print correctly.

Spooling RAW datatype requires less resources than EMF, so
some problems (“Insufficient memory/disk space to print”,
“Slow print speed”, etc.) can be solved by selecting the Always 
spool RAW datatype check box.

Note:
When spooling RAW datatype, print progress as displayed by the
Progress Meter may differ from actual print progress.
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Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box,
where you can make settings for EPSON Status Monitor 3.

You can make the following settings:

Select
Notification

Displays the current error notification settings.

Select the check boxes of the error types for which you
want to receive notification.

Note:
Click the Default button to revert all Select Notification
settings to their defaults.

Select
Shortcut Icon

Select the Shortcut Icon check box and choose an icon
type to have a shortcut icon placed in your Windows
taskbar. You can click the shortcut icon in the taskbar to
open EPSON Status Monitor 3, or right-click the icon to
access some of the printer utilities.
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Getting Information Through Online Help

Your printer software has an extensive online help feature, which
provides you with instructions on printing, making printer driver
settings, and using printer utilities.

Refer to the appropriate section below.

Accessing help from your application

Choose Print or Print Setup from the File menu, and then click
Printer, Setup, Options, or Properties. (Depending on your
application, you may need to click a combination of these
buttons.)

You can get specific help related to any item on a menu by
right-clicking the item, then clicking the What掇 This? command.

You can also view a detailed explanation of a setting or option by
clicking the button on the top right of the printer driver
window, and then clicking the item.

Accessing help from the Windows Start menu

1. For users of Windows Me, 98, 95, 2000 and NT 4.0, click Start,
point to Settings, then click Printers.
For Windows XP users, click Start, Control Panel, Printers 
and Other Hardware, then Printers and Faxes.

2. For Windows Me, 98 and 95 users, select your printer, then
click Properties on the File menu.

Allow
monitoring of
shared
printers

Select this check box to allow monitoring of a shared
printer by other computers.
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For Windows XP and 2000 users, select your printer, then
click Printing Preferences on the File menu.

For Windows NT 4.0 users, select your printer, then click
Document Defaults on the File menu.

The printer software opens.

You can get specific help related to any item on a menu by
right-clicking the item and then clicking the What掇 This?
command.

You can also view a detailed explanation of a setting or option by
clicking the button on the top right of the printer driver
window, and then clicking the item.
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For Users of Mac OS 8.1 or Later (Except Mac
OS X)

Printer Software Introduction

The printer software which comes with your printer includes a
printer driver and printer utilities. The printer driver lets you
choose from a wide variety of settings to get the best results from
your printer. The printer utilities help you check the printer and
keep it in top operating condition.

The printer driver settings and utilities appear in the following
dialog boxes.

These dialog boxes can be accessed as described below.

Dialog Box Settings and Utilities

Print Media Type, Mode, Copies, Pages, Ink

Page Setup Paper Size, Orientation, Rotate by 180 degrees, Reduce
or Enlarge, Printable Area

Layout Fit to Page, Watermark, Multi-Page, Print Order

Utility EPSON Status Monitor, Nozzle Check, Head Cleaning,
Print Head Alignment, Configuration (dialog box)

Dialog Box How to Access

Print Click Print on the File menu of your application or click
Options in the Page Setup dialog box.

Page Setup Click Page Setup on the File menu of your application.

Layout Click the Layout icon button in the Print dialog box.

Utility Click the Utility icon button in the Print or Page Setup
dialog box.
85



In addition, you can access the dialog boxes below from the Print
dialog box.

In addition to the printer software information in this guide, you
can get more details by clicking the help icon in any of the dialog
boxes in the printer software.

If you encounter any problems when using the printer software,
refer to the EPSON Technical Support Web Site. To access the Web
site from the printer software CD-ROM, insert the CD in the
CD-ROM drive and double-click the EPSON icon, then select
Technical Support Web Site and click .

Making Settings in the Print Dialog Box

You can make Media Type, Mode, Ink, Copies, and Pages settings
in the Print dialog box. From this dialog box, you can also access
other dialog boxes, from which you can set the print time, preview
the document before printing, and save spool data as a file. Refer
to the appropriate section below.

Making the Media Type setting

The Media Type setting determines what other settings are
available, so you should always make this setting first.

Dialog Box How to Access

Background
Printing

Click the Background Printing icon button in the Print
dialog box.

Preview Click the Preview icon button in the Print dialog box
and then click Preview.

Save File Click the Preview icon button in the Print dialog box
until the Print button changes into the Save File button
and then click the Save File button.
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In the Print dialog box, select the Media Type setting that matches
the paper that is loaded in the printer. To find out what media
type you are using, find your media in the Media Type Settings
list, and refer to the corresponding media type under which it is
grouped (shown in larger type). For some media, there are several
Media Type settings from which to choose.

Media Type Settings

Making the Mode setting

The Mode settings in the Print dialog box give you three levels of
control over the printer software, as explained below:

In addition to making comprehensive Mode settings that affect
overall print quality, you can also modify individual aspects of
your printout using the settings contained in the Page Setup and
Layout dialog boxes. See “Making Settings in the Page Setup
Dialog Box” on page 97 or “Making Settings in the Layout Dialog
Box” on page 102 for details.

Automatic This mode provides the quickest and easiest
way to start printing. See “Using the
Automatic mode” on page 88 for details.

PhotoEnhance This mode lets you choose from a variety of
image-correction settings specially
designed for photos. See “Using the
PhotoEnhance mode” on page 88 for
details.

Custom This mode lets you choose from a list of
ready-made or personalized settings suited
to the kind of document that you want to
print. When Custom is selected, the
Advanced button is enabled, allowing you
to access the Advanced dialog box. See
“Using the Custom mode” on page 90 for
details.
87



Using the Automatic mode

When Automatic is selected as the Mode setting in the Print
dialog box, the printer software takes care of all detailed settings
based on the current Media Type and Ink settings. To make the
Ink setting, see “Making the Ink setting” on page 93. To make the
Media Type setting, see “Making the Media Type setting” on page
86.

Note:
Depending on the media selected in the Media Type list (while
Automatic is selected), a slider appears to the right of the Mode options
that lets you choose Quality or Speed. Select Quality when print
quality is more important than speed.

Using the PhotoEnhance mode

The PhotoEnhance mode provides a variety of image-correction
settings that you can apply to your photos before printing.
PhotoEnhance does not affect your original data.
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Note:
❏ This mode is only available when printing 32-bit color data.

❏ Printing with PhotoEnhance selected may increase the time
required for printing, depending on your computer system and the
amount of data contained in your image.

You can select from the following settings.

Selecting PhotoEnhance also enables the Digital Camera 
Correction check box. Select this check box when you are printing
photos taken with a digital camera to give your printed images
the smooth, natural appearance of photographs taken with a film
camera.

Standard This setting provides standard image correction for most
photos. Try this first.

People This setting is best for photos of people.

Nature This setting is best for outdoor scenery such as
mountains, skies, and oceans.

Soft Focus This setting makes your photos look as if they were taken
with a soft-focus lens.

Sepia This setting applies a sepia tone to your photos.
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Using the Custom mode

Selecting Custom as the Mode option enables the Custom Settings
list, from which you can choose a ready-made setting designed
for printing text and graphs. Or, you can select ColorSync, a
color-matching method. You can also create and save your own
custom settings. For details on making your own custom settings
see “Making Advanced settings” on page 91.

You can select from the following ready-made settings.

When you select a custom setting, other settings such as Print
Quality, Halftoning, and Color Management are made
automatically. Changes to these settings are reflected in the
display at the left side of the Print dialog box.

Follow the steps below to select a custom setting.

1. Select Custom as the Mode setting in the Print dialog box.
This enables the Custom Settings list, located to the right of
the Custom radio button.

2. From the Custom Settings list, select the most appropriate
setting for the type of document or image that you want to
print.

Economy This setting is best for printing drafts of text.

ColorSync This setting automatically adjusts printout
colors to match colors on your screen.
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3. Confirm that the Media Type and Ink settings in the Print
dialog box are correct. For details, see “Making the Ink
setting” on page 93 or “Making the Media Type setting” on
page 86.

Making Advanced settings

The settings in the Advanced dialog box give you complete
control over your printing environment. Use these settings to
experiment with new printing ideas or to fine-tune a range of
print settings to meet your individual needs. Once you are
satisfied with your new settings, you can give them a name and
add them to the Custom Settings list in the Print dialog box.

Follow the instructions below to make Advanced settings.

1. Select Custom as the Mode setting in the Print dialog box and
then click Advanced. The Advanced dialog box opens.

2. Select a Media Type setting that is appropriate for the media
loaded in the printer. For details, see “Making the Media Type
setting” on page 86.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.
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5. Make other settings as necessary. For details, see online help.

Note:
❏ The PhotoEnhance feature only affects images, not text or

graphs. For example, if Monochrome is selected from the Tone
list (enabled when PhotoEnhance is selected), only the images
in a document will be printed in monochrome. Any colored text
or graphs in the same document will be printed in color.

❏ Some settings may be unavailable, depending on the Media
Type, Ink, and Print Quality settings that you make.

6. Click OK to apply your settings and return to the Print dialog
box. To return to the Main menu without applying your
settings, click Cancel. To save your Advanced settings,
proceed to the next section.

Saving and deleting your settings

To save your Advanced settings in the Custom Settings list, click
Save Settings in the Advanced dialog box. The Custom Settings
dialog box appears.

Type a unique name (up to 16 characters) for your settings in the
Name text box, then click Save. Your Advanced settings will be
added to the Custom Settings list. You can save up to 100 different
custom settings.

Note:
❏ You cannot apply the names of EPSON ready-made settings or

color-matching methods to your custom settings.
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❏ You cannot delete the ready-made settings or color-matching
methods from the Custom Settings list.

To delete a setting from the Custom Settings list, select it in the
Custom Settings dialog box and click Delete.

Using your saved settings

To use your saved settings, select Custom as the Mode setting in
the Print dialog box, then select your setting in the Custom
Settings list.

If you change the Media Type or Ink settings while one of your
customized settings is selected in the Custom Settings list, the
selection shown in the list returns to Custom Settings. The
customized setting that was previously selected is not affected by
the change. To return to your customized setting, simply reselect
it in the list.

Making the Copies setting

To make the Copies setting, enter the number of copies that you
want to print in the Copies text box.

Making the Pages setting

To make the Pages setting, select either All or Range. If you select
Range, enter the appropriate range of pages in the Range text
boxes.

Making the Ink setting

To make the Ink setting, click Color to print in color, or Black to
print in black-and-white or grayscale.

Setting the print time

You can specify the time that you want the printer to begin
printing your document. Follow the steps below.
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1. Click the Background Printing icon button in the Print
dialog box. The Background Printing dialog box opens.

2. Select On as the Background Printing option, if necessary.

3. Select Urgent, Normal, Print at, or Hold as the Print Time
option.

If you select Print at, use the arrows beside the date and time
boxes to specify the date and time that you want to print the
document.

Note:
Make sure that the computer and printer are turned on at the date
and time you specify.

4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure that your print settings are
as you want them, then click Print.

Note:
You can check or change the priority of print jobs using the EPSON
Monitor3 utility. See “Using EPSON Monitor3” on page 158 for
details.
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Previewing your printout

The Preview feature allows you to see how your document will
look before actually printing it. Follow these steps to preview
your document.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box. The
Print button changes into a Preview button.

Note:
Use the Preview icon button to toggle between the Print, 

Preview, and Save File modes. Click the icon button to select
the mode that you want. For information on the Save File mode, see
“Saving spool data as a file” on page 96.

3. Click the Preview button. The Preview dialog box opens and
displays a preview of your document.
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The Preview dialog box contains several icon buttons that you
can use to perform the following functions.

4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click
Cancel. The Preview and Print dialog boxes close with the
current print settings preserved. Open the Print dialog box
again to make additional changes to the print settings.

Saving spool data as a file

You can save spool data as a file using the Save File icon button
in the Print dialog box. This feature lets you use the saved spool
data to print the document at a later time simply by
double-clicking the saved file. Follow the steps below.

Edit
Watermark

Click this button to select, move, and
resize watermarks.

Zoom Click this button to enlarge or reduce
the size of the previewed page.

Show/Hide
Printable Area

Click this button to display or hide the
borderlines which indicate the
printable area. The printer cannot
print anything which is outside of this
area.

Show/Hide
Watermark
Settings

Click this button to open the
Watermark Edit dialog box, where
you can add watermarks to the
document and change any of the
current watermark settings.

Add page Click these buttons to add or remove
selected pages from the list of pages
to be printed.

Remove page
96



Note:
Use the Preview icon button to toggle between the Print, 

Preview, and Save File modes. Click the icon button to select the
mode you want.

1. Make your printer driver settings.

2. Click the Preview icon button in the Print dialog box
repeatedly until the Print button changes into the Save File
button.

3. Click the Save File button. The following dialog box appears.

4. Select the location where you want to save the file, then type
a file name in the Save As text box and click Save.

5. When you want to print the document, double-click the file
to open EPSON Monitor3, make sure that the correct
document is selected, then click the Resume button to send
the data to the printer.

Making Settings in the Page Setup Dialog Box

In the Page Setup dialog box, you can change the paper size,
specify the paper orientation, rotate your document by 180
degrees, reduce or enlarge your printout, and adjust the printable
area.
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Choose Page Setup from the File menu of your application. The
Page Setup dialog box appears.

You can make the following settings in the Page Setup dialog box.

Paper Size Select the paper size that you want to use. If you
want to define a custom paper size, see “Defining a
custom paper size” on page 100.
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No Margins Check this box when you want to print with no
margins.

This feature prints to all four edges of the paper.

You can use the following media with this feature.

Photo Quality Ink Jet Paper:
A4, Letter, 5 × 8”

Matte Paper-Heavyweight:
A4, Letter

Photo Paper:
A4, Letter, 4 × 6”, 4 × 6” (No Perforations),
100 × 150 mm, 200 × 300 mm, 210 × 594 mm

Premium Glossy Photo Paper
5 × 7”

Note:
If your application has margin settings, make sure
they are set to zero before printing.

Printing with this feature selected takes longer than
for normal printing.

Because this feature enlarges the image to a size
slightly larger than the paper size when Sheet Feeder
is selected as the Paper Source setting, the portion
of the image that extends beyond the edges of the
paper will not be printed.

Print quality may decline in the top and bottom
areas of the printout, or the area may be smeared
when printing on media other than that listed
above. We recommend printing a single sheet to
check quality before printing large jobs.

You cannot use this feature with ColorLife Photo
Paper, Photo Quality Glossy Film, Ink Jet
Transparencies, Iron-On Cool Peel Transfer Paper or
360 dpi Ink Jet Paper.

Orientation Select Portrait (tall) or Landscape (wide) to change
the orientation of your printout. To print close to the
bottom of the page, select the Rotate by 180
degrees check box.

Reduce or Enlarge Use this setting to reduce or enlarge the size of your
image from 25% to 400%.
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Defining a custom paper size

You can define a custom paper size. To do so, you can either create
a new paper size, or base your custom paper size on a pre-existing
paper size. Refer to the appropriate section below.

Creating a new paper size

If the appropriate paper size is not included in the Paper Size list
in the Page Setup dialog box, follow the steps below to define a
new custom paper size.

1. In the Page Setup dialog box, click Customize. The following
dialog box appears.

Printable Area This feature is not available when No Margins is
selected.

To center the printout, select Centered. To increase
the printable area, select Maximum. Do not select
Maximum while using Premium Glossy Photo Paper.

Note:
The print quality may decline at the edges of the
printout when Maximum is selected as the Printable
Area setting. Before printing large jobs using this
setting, print a single sheet to confirm quality.
When Maximum is selected, make sure that the
paper loaded in the sheet feeder is not curled.
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2. To define a new paper size, click New. The dialog box updates
to allow you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size list.

4. Specify the measurement unit as either inch or cm.

5. Enter the width and the height of your paper by typing the
text in the appropriate text box.

6. Specify the margins by typing in the Margin text boxes or by
manipulating the preview image.

7. Click OK to return to the Page Setup dialog box.

You can define up to 100 paper sizes. The paper size names you
create will appear in the Paper Size list in the Page Setup dialog
box.

To delete a custom paper size, click Customize in the Page Setup
dialog box, select the paper size from the list in the Custom Paper
dialog box, and click Delete.
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Copying a pre-existing paper size to use as a template

Follow the steps below to copy an existing paper size to use as a
template.

1. Select the existing paper size to copy and click Copy.

2. Specify the measurement unit as either inch or cm.

3. Specify the margins by typing in the Margin text boxes or by
manipulating the preview image.

4. Click OK.

Making Settings in the Layout Dialog Box

You can modify the page layout of your document using the
printer driver settings located in the Layout dialog box. To open
this dialog box, click Print on the File menu of your application,
then click the Layout icon button in the Print dialog box.
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The Layout dialog box allows you to automatically match the
document size to the paper size, print two or four pages on a single
sheet of paper, print poster-size images by enlarging one page to
cover several sheets, place watermarks on documents, or specify
the printing order for your print job. Refer to the appropriate
section below.

Making the Fit to Page setting

You can proportionally enlarge or reduce the size of the image to
make it fit a selected paper size. To do this, select the Fit to Page
check box, then select the paper size in the Output Paper Size list.

Making Watermark settings

To print a watermark on your document, select the Watermark
check box in the Page Layout dialog box.

Select the watermark that you want to print from the Name list,
then specify its position, size, color, and intensity. You can change
the position and size of the watermark by dragging it with your
mouse in the preview window at the left.
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You can also add your own text-based or image-based
watermarks to the Name list. Follow these steps.

1. Click Add/Del beside the Name list. The following dialog box
appears.

2. To use an image file as a watermark, click Add PICT. Specify
the desired image file, then click Open.

To create a text-based watermark, click Add Text. Type the
text in the Text text box, select a font and a text style, then click
OK.
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3. The image file name or the watermark text appears in the
Mark Name list in the Watermark dialog box. To change the
name of an image watermark, click it in the list, then type a
new name. When a text watermark is selected in the Name
list, you can edit the text or change the font and text style by
clicking Edit Text.

4. Click OK to add your watermark to the Name list in the Page
Layout dialog box.

Making Multi-Page settings

Selecting the Multi-Page check box allows you to choose between
the N-up and Poster settings. Refer to the appropriate section
below.
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Making N-up settings

Select the N-up option under Multi-Page in the Layout dialog box
to print two or four pages of your document on one sheet of paper.

When N-up is selected, you can make the following settings:

2 Pages
4 Pages

Prints two or four pages of your document on a
single piece of paper.

Page Order Allows you to specify the order in which the
pages will be printed on the sheet of paper.

Print page frames Prints frames around the pages printed on each
sheet.
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Making Poster settings

A single document page can be enlarged to cover 4, 9, or 16
printed sheets of paper. Select the Poster option under
Multi-Page to print a poster-size image.

You can make the following settings.

If you only want to print a few of the panels without printing the
entire poster, click Panel Selection, then click the panels that you
do not wish to print, and then click OK. Only the panels that you
did not click will be printed.

1 page covers xx sheets Specifies how many printed sheets of paper
the enlarged document page is to cover. You
can select 4, 9, or 16 sheets.

Overlapping Alignment
Marks

Slightly overlaps the images and prints
alignment markers so that they can be
aligned more precisely.

Trim Lines Prints border lines on the images to guide you
when trimming the pages.

Panel Selection Click the Panels you do not need to print, then
click the OK button to print the remaining
panels.
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Making Print Order settings

You can specify the printing order for your print job. When
printing multiple copies of your document, select Collate to print
one complete document set at a time. Select Reverse Order to
print your documents in reverse order, starting with the last page.

Using the Printer Utilities

EPSON printer utilities allow you to check the current printer
status and to perform printer maintenance from your computer.

To use the utilities, click the Utility icon button in the Print or
Page Setup dialog box, then click the button for the utility that
you want to use.

Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment
utilities while printing is in progress; otherwise, your printout may be
marred.

Refer to the appropriate section below.
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EPSON StatusMonitor

The StatusMonitor utility monitors the printer status. If it detects
a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining
before printing.

To use the StatusMonitor, click the EPSON StatusMonitor button
in the Utility dialog box. For details, see “Using EPSON
StatusMonitor” on page 153.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for
clogging. Check the nozzles if you notice print quality has
declined and after cleaning to confirm that the print head nozzles
have been cleared. If the nozzle check indicates the print head
needs cleaning, you can access the Head Cleaning utility directly
from the Nozzle Check utility. For details, see “Checking the Print
Head Nozzles” on page 161.

Head Cleaning

The Head Cleaning utility cleans the print head. You may need
to clean the print head if you notice print quality has declined.
Use the Nozzle Check utility first to confirm that the print head
needs to be cleaned. For details, see “Cleaning the Print Head” on
page 164.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this
utility if you notice a misalignment of vertical or horizontal lines.
Follow the on-screen instructions to use this utility.

When you run the Print Head Alignment utility, the printer prints
test patterns that you use to check the print head alignment.
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Here are sample printouts.

From each pattern on the printed test sheet, choose the vertical
line that is aligned best. For each pattern, select the corresponding
line number from the appropriate drop-down list box in the Print
Head Alignment dialog box, then click Finish to put the new
settings into effect.

Note:
If you cannot find a line which is aligned correctly, select the number of
the line which is the closest to being correct and click Realignment. The
lines you selected will be reset to the center (number 8) position and the
alignment test sheet will be printed again.

Configuration

Click this button to open the Configuration dialog box, where you
can change the method by which the StatusMonitor utility notifies
you when the printer status changes. For details, see “Using the
Configuration Settings dialog box” on page 156.
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Getting Information Through Online Help

Your printer software has an extensive online help feature, which
provides you with instructions on printing, making printer driver
settings, and using the printer utilities.

To access online help, choose Print or Page Setup from the File
menu of your application. Then, click the Help icon button.
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For Mac OS X Users

Printer Software Introduction

The printer software which comes with your printer includes a
printer driver and printer utilities. The printer driver lets you
choose from a wide variety of settings to get the best results from
your printer. The printer utilities help you check the printer and
keep it in top operating condition.

This chapter includes descriptions of the settings and utilities that
are available in these dialog boxes. Refer to the appropriate
section below.

For information on accessing the printer software, see the
following.

“Accessing the Printer Software for Macintosh” on page 141

You can also get more information about the printer software by
clicking the help icon in any of the dialog boxes in the printer
software.

If you encounter any problems when using the printer software,
refer to the EPSON Technical Support Web Site. See “Technical
Support Web Site” on page 275.

Making Settings in the Print Dialog Box

You can make Media Type, Mode, Ink, Copies, and Pages settings
in the Print dialog box. From this dialog box, you can preview the
document before printing. Refer to the appropriate section below.
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Making the Media Type setting

The Media Type setting determines what other settings are
available, so you should always make this setting first.

In the Print dialog box with the Print Settings option selected,
select the Media Type setting that matches the paper that is loaded
in the printer. To find out what media type you are using, find
your media in the Media Type Settings list, and refer to the
corresponding media type under which it is grouped (shown in
larger type). For some media, there are several Media Type
settings from which to choose.

Note:
For the latest information on available media, visit our regional customer
service web site. See “Contacting Customer Support” on page 275 for
details.

Media Type Settings

Making the Mode setting

The Mode settings in the Print dialog box with the Print Settings
option selected support several options. The Print dialog box with
the Print Settings option selected is shown below:
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The Mode settings are explained below:

In addition to making comprehensive Mode settings that affect
overall print quality, you can also modify individual aspects of
your printout using the settings contained in the Page Setup
dialog box. See “Making Settings in the Page Setup Dialog Box”
on page 125.

Refer to the appropriate section below.

Automatic This mode provides the quickest and easiest
way to start printing. See “Using the
Automatic mode” on page 115 for details.

Custom This mode lets you choose from a list of
ready-made or personalized settings suited
to the kind of document that you want to
print. See “Using the Custom mode” on
page 116 for details.

Advanced Settings This mode lets you make more detailed
printing settings. See “Using the Advanced
Settings mode” on page 117 for details.
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Using the Automatic mode

When Automatic is selected as the Mode setting in the Print
dialog box in which the Print Settings option is selected, the
printer software takes care of all detailed settings based on the
current Media Type and Ink settings. To make the Ink setting, see
“Making the Ink setting” on page 119. To make the Media Type
setting, see “Making the Media Type setting” on page 113.

Note:
Depending on the media selected in the Media Type list (while
Automatic is selected), a slider appears to the right of the Mode options
that lets you choose Quality or Speed setting. Select Quality when
print quality is more important than speed.
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Using the Custom mode

Selecting Custom as the Mode option enables the Custom
Settings list, from which you can choose a ready-made setting
designed for printing text and graphs. Or, you can select
ColorSync, a color-matching method. You can also create and
save your own custom settings. For details on making your own
custom settings see “Using the Advanced Settings mode” on page
117.

By default, you can choose from the following:

When you select a custom setting, other settings such as Print
Quality and Color Management are made automatically. Changes
to these settings are reflected in the display at the left side of the
Print dialog box.

Ready-made
setting

Description

Economy This setting is best for printing drafts of text.

Color-matching
method

Description

ColorSync This method automatically adjusts printout colors to
match the colors on your screen.
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Follow the steps below to select a custom setting.

1. Confirm that the Media Type and Ink settings in the Print
dialog box are correct. For details, see “Making the Ink
setting” on page 119 or “Making Settings in the Page Setup
Dialog Box” on page 125.

2. Select the Print Settings option from the pop-up menu in the
Print dialog box.

3. Select Custom as the Mode setting in the Print dialog box.
This enables the Custom Settings list, located to the right of
the Custom radio button.

4. From the Custom Settings list, select the most appropriate
setting for the type of document or image that you want to
print.

Using the Advanced Settings mode

Selecting Advanced Settings as the Mode option gives you
complete control over your printing environment. Use these
settings to experiment with new printing ideas or to fine-tune a
range of print settings to meet your individual needs.

Follow the instructions below to make Advanced settings.

1. Select the Print Settings from the pop-up menu in the Print
dialog box.
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2. Select Advanced Settings as the Mode option in the Print
dialog box.

3. Choose Color or Black as the Ink setting.

4. Specify a Print Quality setting.

5. Make other settings as necessary. For details, see online help.

Note:
Some settings may be unavailable, depending on the Media Type,
Ink, and Print Quality settings that you make.

Making the Copies setting

To make the Copies setting, select Copies & Pages from the
pop-up menu, and then enter the number of copies that you want
to print in the Copies text box.

Making Print Order settings

To make print order setting, select Copy & Pages from the pop-up
menu, and then select Collated to print one complete document
set at a time when printing multiple copies.
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Making the Pages setting

To make the Pages setting, select Copies & Pages from the
pop-up menu, and then select either All or From and to. If you
select From and to, enter the first page of the appropriate range
of pages in the From text box and the last page in the to text box.

Making the Ink setting

To make the Ink setting, select Print Settings from the pop-up
menu, and then click Color to print in color, or Black to print in
black-and-white or grayscale.

Previewing your printout

The Preview feature allows you to see how your document will
look before actually printing it. Follow these steps to preview
your document.

1. Make your printer driver settings.
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2. Click Preview in the Print dialog box. The Preview dialog box
appears and displays a preview of your document.

Note:
Preview is a standard feature of Mac OS X.
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Making N-up settings

Select Layout from the pop-up menu as the Multi-Page setting to
print multiple pages of your document on one sheet of paper.

When Layout is selected, you can make the following settings:

Note:
The Layout settings are a standard feature of Mac OS X.

Saving the document as a PDF file

You can save the document as a PDF file by selecting Output 
Options from the pop-up menu in the Print dialog box. Follow
the steps below.

Pages per Sheet Prints multiple pages of your document on a
single piece of paper. You can select from 1, 2,
4, 6, 9, or 16.

Layout Direction Allows you to specify the order in which the
pages will be printed on the sheet of paper.

Border Prints a border around the pages printed on
each sheet. You can select from None, Single
hairline, Single thin line, Double hairline, or
Double thin line.
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1. Make your printer driver settings.

2. Select Output Options from the pop-up menu and select the
Save as File check box. The Print button changes into the
Save button.

3. Click the Save button. The following dialog box appears.

4. Select the location where you want to save the file, type a file
name in the Save As text box, and then click Save.

Note:
The Save as File setting is a standard feature of Mac OS X.

Making the Color Management setting

Selecting Color Management from the pop-up menu gives you
control over the color matching and adjustment methods
provided with the printer driver.

Follow the instructions below to make Color Management
settings.
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1. Select Color Management from the pop-up menu in the Print
dialog box. The following dialog box appears.

2. Make the settings as necessary. For details, see online help.

Showing the current settings in the Print dialog box

In the Print dialog box with the Summary option selected, you
can confirm the current settings in the Print dialog box.
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Select Summary from the pop-up menu. The following dialog box
appears.

The current settings of Copies & Pages, Layout, Output Options,
and Print Settings are displayed in the list.

Note:
The Summary option is a standard feature of Mac OS X.

Saving and using your settings in the Print dialog box

Saving your settings in the Print dialog box

To save your settings in the Print dialog box, select Save Custom 
Setting from the pop-up menu.

Your settings will be saved as Custom in the Saved Settings list. You
can save up to only one set of custom settings.

Note:
The Custom Setting option is a standard feature of Mac OS X.
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Using your saved settings in the Print dialog box

To use your saved settings, select Custom as the Saved Settings
in the Print dialog box.

If you change the Media Type or Ink settings while your
customized setting is selected in the Saved Settings list, your
saved setting is not affected by the change. To return to your saved
setting, simply reselect it in the list.

Making Settings in the Page Setup Dialog Box

In the Page Setup dialog box, you can change the paper size,
specify the paper orientation, and reduce or enlarge your
printout.

Choose Page Setup from the File menu of your application. The
Page Setup dialog box appears.
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You can make the following settings in the Page Setup dialog box.

Showing the current settings in the Page Setup dialog box

In the Page Setup dialog box with the Summary option selected
under Settings, you can confirm the current settings in the Page
Setup box.

Select Summary as Settings. The following dialog box appears.

The current settings of Format for, Document size, Orientation,
and Scale are displayed in the list.

Settings Select Page Attributes or Summary. When Page
Attributes is selected, the page setting items will be
displayed. When Summary is selected, a list of the
current settings will be displayed. For more
information on Summary, see “Showing the current
settings in the Print dialog box” on page 123.

Format for Select the printer to be set up in the Page Setup
dialog box.

Paper Size Select the paper size that you want to use.

Orientation Select Portrait (tall) or Landscape (wide) to change
the orientation of your printout.

Scale Use this setting to reduce or enlarge the size of your
image.
126



Note:
The Summary option is a standard feature of Mac OS X.

Using the Printer Utilities

EPSON printer utilities allow you to check the current printer
status and to perform printer maintenance from your computer.

To use the utilities, double-click the EPSON Printer Utility icon in
the Applications folder in Macintosh HD (by default setting), and
then click the button for the utility that you want to use.

Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment
utilities while printing is in progress, or your printout may be marred.

Refer to the appropriate section below.
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EPSON StatusMonitor

The StatusMonitor utility monitors the printer status. If it detects
a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining
before printing.

To use the StatusMonitor, click the EPSON StatusMonitor button
in the Utility dialog box. For details, see “Using EPSON
StatusMonitor” on page 153.

Nozzle Check

The Nozzle Check utility checks the print head nozzles for
clogging. Check the nozzles if you notice print quality has
declined and after cleaning to confirm that the print head nozzles
have been cleared. If the nozzle check indicates the print head
needs cleaning, you can access the Head Cleaning utility directly
from the Nozzle Check utility. For details, see “Checking the Print
Head Nozzles” on page 161.

Nozzle Check

The Head Cleaning utility cleans the print head. You may need
to clean the print head if you notice print quality has declined.
Use the Nozzle Check utility first to confirm that the print head
needs to be cleaned. For details, see “Cleaning the Print Head” on
page 164.

Print Head Alignment

The Print Head Alignment utility aligns the print head. Use this
utility if you notice a misalignment of vertical or horizontal lines.
Follow the on-screen instructions to use this utility.

When you run the Print Head Alignment utility, the printer prints
test patterns that you use to check the print head alignment.
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Here are sample printouts.

From each pattern on the printed test sheet, choose the vertical
line that is aligned best. For each pattern, select the corresponding
line number from the appropriate drop-down list box in the Print
Head Alignment dialog box, and then click Finish to put the new
settings into effect.

Note:
If you cannot find a line which is aligned correctly, select the number of
the line which is the closest to being correct and click Realignment. The
lines you selected will be reset to the center (number 8) position and the
alignment test sheet will be printed again.

Getting Information Through Online Help

Your printer software has an extensive online help feature, which
provides you with instructions on printing, making printer driver
settings, and using the printer utilities.
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To access online help, choose Print from the File menu of your
application. Next, select Print Settings or Color Management
from the pop-up menu, and then click the Help button.
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Chapter 4

Paper Handling

Single Sheets

Loading single sheets

Follow the steps below to load plain paper into the printer.

1. Lower the output tray and slide out the extension. Next, hold
down the tab on the left edge guide and slide the guide so that
the distance between the edge guides is slightly wider than
the width of your paper.

2. Fan a stack of paper, and then tap it on a flat surface to even
the edges.

3. Load the stack of paper in the sheet feeder with the printable
side up and the right edge of the paper resting against the
right edge guide. Then, slide the left edge guide against the
left edge of the paper. Make sure that the paper stack is loaded
under the tabs inside the edge guides.
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Note:
❏ Leave enough space in front of the printer for the paper to be fully

ejected.

❏ Always load paper into the sheet feeder short edge first.

❏ Make sure that the paper stack fits under the arrow mark inside the
edge guide.

❏ Make sure that the paper is loaded under the tabs inside the edge
guides.
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❏ If the paper is curled, flatten it or curl it slightly toward the opposite
side before loading. Printing on curled paper may cause ink to smear
on your printout, especially when printing with the Minimize 
Margins option selected under More Options (Windows) or the
Maximum option selected for Printable Area (Macintosh).
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Using special media

You can achieve good results with most types of plain paper.
However, coated paper results in higher quality printouts
because these media absorb smaller amounts of ink.

EPSON provides special media that are formulated for the ink
used in EPSON ink jet printers. EPSON recommends using media
distributed by EPSON to ensure high-quality results.

When loading special media distributed by EPSON, read the
instruction sheets packed with the media first and keep the
following points in mind.
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c Caution:
❏ Cleaning sheets packaged with EPSON special media should

not be used with this printer. The cleaning function
performed by these sheets is not necessary with this type of
printer, and the sheets could jam in the printer.

❏ Load the media printable side up in the sheet feeder. See the
instruction sheets packed with the media to determine which
side is the printable side. Some types of media have cut
corners to help identify the correct loading direction, as
shown in the illustration.

Note:
❏ If you extend the printable area by selecting the Minimize Margins

check box under More Options (Windows) or the Maximum option
for Printable Area (Macintosh) in the printer software, the cut
corner on special paper may mar your printout.

❏ Make sure that the paper stack fits under the arrow mark located on
the side surface of the left edge guide.

❏ Make sure that the paper is loaded under the tables inside the edge
guides.
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❏ If the paper is curled, flatten it or curl it slightly toward the opposite
side before loading. Printing on curled paper may cause ink to smear
on your printout, especially when printing with the Minimize 
Margins check box selected under More Options (Windows) or the
Maximum option selected for Printable Area (Macintosh).

❏ If you wish to print on the reverse side of an Ink Jet Card with the
Minimize Margins check box selected under More Options
(Windows) or the Maximum option selected for Printable Area
(Macintosh), curl the card so that it will lie flat before loading.
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Loading capacities for EPSON special media

Refer to the chart below to find the loading capacities for EPSON
special media.

Media Type Loading Capacity

360 dpi Ink Jet Paper and Photo
Quality Ink Jet Paper

Up to 30 sheets.
Up to 10 sheets at a time for legal sized
Photo Quality Ink Jet Paper.

Photo Quality Ink Jet Cards, Ink
Jet Note Cards, and Ink Jet
Greeting Cards

Up to 30 index cards.
Always place the included support
sheet* under the cards.

Photo Quality Glossy Film Up to 30 sheets for A4 size paper. Up to
20 sheets for Letter size paper. One
sheet at a time for A6 size paper.
Always place a support sheet* or a
sheet of plain paper under the glossy
film.

Ink Jet Transparencies Up to 10 sheets. Always place a
support sheet* under the stack of Ink
Jet Transparencies.

Photo Quality Self Adhesive
Sheets

One sheet at a time.

Photo Paper Up to 20 sheets. Always place a
support sheet* under the stack of
Photo Paper.

Photo Stickers 16 and Photo
Stickers 4

One sheet at a time. Always place a
support sheet* under the paper.

Premium Glossy Photo Paper One sheet at a time.
Up to 20 sheets for 5 × 7” size paper.
Always place a support sheet* under
the stack of Premium Glossy Photo
Paper.

Premium Semigloss Photo Paper One sheet at a time.

Premium Luster Photo Paper One sheet at a time.

ColorLife Photo Paper One sheet at a time.
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* Take care not to print on support sheets that are loaded under special
media.

Storing EPSON Photo Paper

Return unused paper to the original package as soon as you finish
printing. EPSON recommends storing your printouts in a
resealable plastic bag. Keep them away from high temperature,
humidity, and direct sunlight.

Envelopes

Follow the steps below to load envelopes into the printer.

1. Lower the output tray and slide out the extension. Next, hold
down the tab on the left edge guide and slide the guide so that
the distance between the edge guides is slightly wider than
the width of your envelope.

Panoramic Photo Paper One sheet at a time. Always place a
support sheet* under the paper.

Iron-On Cool Peel Transfer Paper One sheet at a time.

Economy Paper Up to 20 sheets.

Matte Paper-Heavyweight Up to 20 sheets. Always place a
support sheet* under the stack of
paper.

Double-Sided Matte Paper One sheet at a time. Always place a
support sheet* under the paper.
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2. Load envelopes short edge first with the flap side down, as
shown in the illustration.

Note:
❏ The folding quality and thickness of envelopes vary widely. If

the total thickness of the stack of envelopes exceeds 10 mm, press
each envelope in the stack flat before loading. If print quality
declines when a stack of envelopes is loaded, load one envelope
at a time.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope flaps before loading.

❏ Avoid using envelopes that are too thin as they may curl during
printing.
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Chapter 5

Driver settings

Accessing the Printer Software for Windows

You can access the printer software from most Windows
applications, or from the Windows Start menu.

When you access the printer software from a Windows
application, the settings that you make apply only to the
application you are using.

When you access the printer software from the Start menu, the
settings that you make apply to all of your Windows applications.

Refer to the appropriate section below.

From Windows applications

Follow the steps below to access the printer software.

1. Select Print or Print Setup on the File menu of the Window’s
application.

2. In the dialog box that appears, click Printer, Setup, Options,
or Properties. (Depending on your application, you may
need to click a combination of these buttons.) The printer
software opens.

From the Start menu

Follow the steps below to access the printer software.
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1. For users of Windows Me, 98, 95, 2000 and NT 4.0, click Start,
point to Settings, and then click Printers.
For Windows XP users, click Start, Control Panel, Printers 
and Other Hardware, then Printers and Faxes.

2. For Windows Me, 98, and 95 users, select your printer, and
then click Properties on the File menu.

For Windows XP and 2000 users, select your printer, and then
click Printing Preferences on the File menu.

For Windows NT 4.0 users, select your printer, then click
Document Defaults on the File menu.

The printer software opens.

Accessing the Printer Software for Macintosh

For users of Mac OS 8.1 or later (except Mac OS
X)

The printer driver settings and utilities appear in the following
dialog boxes.

Dialog Box Settings and Utilities

Print Media Type, Mode, Copies, Pages, Ink

Page Setup Paper Size, Orientation, Rotate by 180 degrees, Reduce
or Enlarge, Printable Area

Layout Fit to Page, Watermark, Multi-Page, Print Order

Utility EPSON StatusMonitor, Nozzle Check, Head Cleaning,
Print Head Alignment, Configuration (dialog box)
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These dialog boxes can be accessed as described below.

In addition, you can access the dialog boxes below from the Print
dialog box.

For Mac OS X users

The printer driver settings and utilities appear in the following
dialog boxes. The settings in the Print dialog box change
depending on the option selected on the pop-up menu in the Print
dialog box. The settings in the Page Setup dialog box change
depending on Settings selected in the Page Setup dialog box.

Dialog Box How to Access

Print Click Print on the File menu of your application or click
Options in the Page Setup dialog box.

Page Setup Click Page Setup on the File menu of your application

Layout Click the Layout icon button in the Print dialog box

Utility Click the Utility icon button in the Print or Page Setup
dialog box

Dialog Box How to Access

Background
Printing

Click the Background Printing icon button in the Print
dialog box

Preview Click the Preview icon button in the Print dialog box,
and then click Preview

Save File Click the Preview icon button in the Print dialog box
until the Print button changes into the Save File button,
and then click the Save File button.

Dialog Box Settings and Utilities
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These dialog boxes can be accessed as described below.

Media Type Settings

The Media Type setting determines what other settings are
available, so you should always make this setting first.

Print Common in all options:
Printer, Presets
Copies & Pages option:
Copies, Collated, Pages
Layout option:
Pages per Sheet, Layout Direction, Border
Output Options option:
Save as File, Format
Print Settings option:
Media Type, Ink, Mode
Color Management option:
Color Management
Summary option:
Summary of current settings

Page Setup Page Attributes setting:
Settings, Format for, Paper Size, Orientation, Scale
Summary setting:
Summary of current settings

Utility EPSON StatusMonitor, Nozzle Check, Head Cleaning, Print
Head Alignment

Dialog Box How to Access

Print Click Print on the File menu of your application.

Page Setup Click Page Setup on the File menu of your application.

Utility Double-click the EPSON Printer Utility icon in the
Applications folder in Macintosh HD (by default setting).
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Plain Paper

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON Bright White Ink Jet Paper (A4) S041442

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8") S041121
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EPSON Photo Quality Ink Jet Card (8 × 10") S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8"
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10"
(with envelopes)

S041149
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Matte Paper-Heavyweight

Photo Paper

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

Matte Paper-Heavyweight (8 × 10") S041467

Double-Sided Matte Paper (A4) S041569
S041570

Double-Sided Matte Paper (Letter) S041568

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6") S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Economy Paper (A4) S041579
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Premium Glossy Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

EPSON Premium Glossy Photo Paper (A4) S041285
S041287
S041297
S041624

EPSON Premium Glossy Photo Paper (Letter) S041286

EPSON Premium Glossy Photo Paper (5 × 7") S041464

EPSON Premium Glossy Photo Paper (8 × 10") S041465

EPSON Premium Semigloss Photo Paper (A4) S041332

EPSON Premium Semigloss Photo Paper (Letter) S041331

EPSON Premium Luster Photo Paper (A4) S041602

EPSON Premium Luster Photo Paper (Letter) S041405

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064
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ColorLife Photo Paper

Note
The availability of special media varies by location. For the latest
information on media available in your area, contact EPSON customer
services. See “Contacting Customer Support” on page 275.

EPSON ColorLife Photo Paper (A4) S041560

EPSON ColorLife Photo Paper (Letter) S041500
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Chapter 6

Checking Printer Condition and
Maintaining

Checking the Printer Status

For Windows

Using the Progress Meter

When you send a print job to the printer, the Progress Meter
appears, as shown in the illustration below.

The Progress Meter indicates the progress of the current print job
and provides printer status information when bidirectional
communication between the printer and computer is established.
This meter also displays helpful tips for better printing and error
messages. Refer to the appropriate section below.
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Epson Printing Tips

Tips for getting the most out of your EPSON printer software
appear in the text box at the bottom of the Progress Meter
window. A new tip appears every 30 seconds. For more details
on the tip which is currently displayed, click Details.

Error messages

If a problem occurs during printing, an error message appears in
the text box at the top of the Progress Meter window. For more
detailed information, click Technical Support to access the
Problem Solver HTML manual.

When the ink runs low or out, a How to button appears below the
text box. Click How To and EPSON Status Monitor 3 will lead you
step-by-step through the cartridge replacement procedure.
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Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If
it receives two or more print jobs at one time, it holds them in the
order that they were received (with printers on a network, this
may be called a print queue). When a print job reaches the top of
the line, the EPSON Spool Manager sends the job to the printer.
From the Spool Manager, you can view print status information
about the print jobs which have been sent to your printer. You can
also cancel, pause, and resume selected print jobs.

Note:
EPSON Spool Manager is not available with Windows 2000, XP and
NT 4.0.

After you send a print job, an EPSON Stylus Photo 830 Series 
button appears on the taskbar. Click this button to open the
EPSON Spool Manager.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the
printer status.
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Note:
Before using EPSON Status Monitor 3, be sure to read its README
file. To open this file, click Start, point to Programs (for users of
Windows Me, 98, 95, 2000 and NT 4.0) or All Programs (for Windows
XP users), then to EPSON or EPSON Printers, and then click EPSON 
Stylus Photo 830 Series Readme.

Accessing EPSON Status Monitor 3

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer-shaped shortcut icon on the
Windows taskbar. For details on making settings for this icon,
see “Monitoring Preferences” on page 82.

❏ Open the printer software, click the Utility tab, and then click
the EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window
appears.

Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information.
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❏ Current Status:
EPSON Status Monitor 3 provides you with detailed printer
status information, a graphic display, and status messages. If
the ink runs low or out, the How to button appears in the
EPSON Status Monitor 3 window. Clicking How to displays
ink cartridge replacement instructions and moves the print
head to the ink cartridge replacement position.

❏ Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the
amount of ink remaining, and an estimate of the number of
pages that can be printed before ink runs out. For the color
ink cartridge, the chamber with the least amount of ink
remaining determines the level that is displayed for all of the
colors in the cartridge.

❏ Ink Cartridge Information:
You can view information about the installed ink cartridges
by clicking Information.

❏ Technical Support
You can access the Problem Solver HTML manual from
EPSON Status Monitor 3. If you encounter a problem, click
Technical Support in the EPSON Status Monitor 3 window.

For Macintosh

Using EPSON StatusMonitor

EPSON StatusMonitor monitors the printer. If it detects a printer
error, it will inform you with an error message.
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When the ink runs low or out, a How to button appears. Click How 
to and EPSON StatusMonitor will lead you step-by-step through
the ink cartridge replacement procedure.

You can also use this utility to check ink levels before printing.
When open, EPSON StatusMonitor displays the amount of ink
remaining at the time it was opened. To update the ink level
information, click Update.

Accessing EPSON StatusMonitor

Follow the steps below to access EPSON StatusMonitor.

For users of Mac OS 8.1 or later (except Mac OS X)

1. Click Print or Page Setup on the File menu of your
application. The Print dialog box appears.
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2. Click the StatusMonitor icon button or click the Utility
icon button, and then click the EPSON StatusMonitor button
in the Utility dialog box. The StatusMonitor dialog box
appears.

For Mac OS X users

1. Double-click Macintosh HD (by default setting), double-click
the Applications folder, and then double-click the EPSON 
Printer Utility icon. The Printer List window appears.

2. Select your printer, and then click OK. The EPSON Printer
Utility dialog box appears.
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3. Click the EPSON StatusMonitor button. The StatusMonitor
dialog box appears.

Using the Configuration Settings dialog box

To change the way that the StatusMonitor utility monitors your
printer, or to change the way that your printer handles print jobs,
follow the steps below.

Note:
This feature is not available with Mac OS X.

1. Click Print or Page Setup on the File menu of your
application.

2. Click the Utility icon button.
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3. Click Configuration. The Configuration Settings dialog box
appears.

In the Configuration Settings dialog box, you can make the
following settings:

Error notification Choose the method by which EPSON
StatusMonitor will notify you in case of an
error.

Warning Choose the method by which EPSON
StatusMonitor will notify you if a warning
message becomes necessary.

Temporary Spool folder Specify the folder in which print data will be
temporarily spooled.

Temporary High Speed
Copies folder

Specify the folder in which multiple-copy
print data will be temporarily stored.

Data will be sent to the
printerafter being stored
on your disk.

Select this check box to prevent horizontal
banding in printouts that contain images by
having the computer temporarily store
image data on its hard drive. The computer
will then send the image data to the printer
as a whole rather than as rectangular
bands.

Check for errors before
starting to print.

Select this check box to have the printer
check for errors before starting to print.
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Using EPSON Monitor3

After you send a print job to the printer, you can use the EPSON
Monitor3 utility to check, cancel, or change the priority of print
jobs that are queued for printing. This utility also shows the status
of the job currently being printed.

Note:
This feature is not available with Mac OS X.

Accessing EPSON Monitor3

To access EPSON Monitor3, follow these steps.

1. First, turn on Background Printing in the Chooser or in the
Background Printing dialog box.

2. Send a print job to the printer.

3. Select EPSON Monitor3 from the Application menu at the
right end of the menu bar. The EPSON Monitor3 dialog box
appears.

Check the ink level
before starting to print.

Select this check box to have the printer
check the ink levels before starting to print.
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Note:
You can also open EPSON Monitor3 by double-clicking the EPSON 
Monitor3 icon in the Extensions folder.

Managing print jobs using EPSON Monitor3

Using EPSON Monitor3, you can manage print jobs as described
below:

❏ Use the buttons below to hold, resume, and delete print jobs.
Select the print job that you want to manage, and then click
the appropriate button.

❏ Click Stop Print Queue to stop printing. Click Start Print 
Queue to resume printing.

❏ Use the buttons below to start the printer utilities.

❏ Double-click a file in the list to preview it (this function is
disabled when you are printing the ESC/P command file).

❏ Double-click Copies to change the number of copies of the
selected print job that will be printed.

Hold Pauses printing and keeps the current
print job at the top of the print queue.

Resume Resumes printing.

Delete Stops printing and deletes the print job
from the print queue.

Print head
cleaning

Starts the Print Head Cleaning utility.

StatusMonitor Starts EPSON StatusMonitor, which
displays the amount of ink remaining.
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❏ Click the Show details arrow to open an extension at the
bottom of the EPSON Monitor3 dialog box similar to the one
below. The extension displays detailed information on the
selected document’s printer software settings.

Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the
steps in this section.

Note:
You can also change the priority of print jobs whose print times were
previously set in the printer software’s Background Printing dialog box.

1. In the Document Name column, select the print job for which
you want to change the priority.
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2. Click the Show details arrow to open an extension at the
bottom of the EPSON Monitor3 dialog box, similar to the one
below.

3. From the Priority list, select Urgent, Normal, Hold, or Print 
Time.

Note:
If you select Print Time, a dialog box appears, allowing you to
specify the date and time that the document will be printed. Make
sure that your printer and computer are turned on at the specified
time.

Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in
the printed image are missing, you may be able to identify the
problem by checking the print head nozzles.
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You can check the print head nozzles from your computer using
the Nozzle Check utility in the printer software, or from the
printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility

Refer to the appropriate section below to use the Nozzle Check
utility.

Note:
Do not use the Nozzle Check utility while printing is in progress;
otherwise, your printout may be marred.

For Windows users

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4- or Letter-size paper is loaded in the sheet
feeder.

2. Access the printer software, click the Maintenance tab, and
then click the Nozzle Check button.

3. Follow the on-screen instructions.

For Macintosh users

Follow the steps below to use the Nozzle Check utility.

1. For users of Mac OS 8.1 or later (except Mac OS X), access the
Print or Page Setup dialog box, click the Utility icon
button, and then click the Nozzle Check button in the Utility
dialog box.
For Mac OS X users, double-click the EPSON Printer Utility
icon in the Applications folder in Macintosh HD (by default
setting), select your printer, click OK in the Printer List
window, and then click the Nozzle Check button in the Utility
dialog box.
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2. Follow the on-screen instructions.

Using the control panel buttons

Follow the steps below to check the print head nozzles using the
control panel buttons.

1. Turn off your printer.

2. Make sure that A4 or Letter size paper is loaded in the sheet
feeder.

3. Hold down the b maintenance button (➀ in the illustration
below) and press the P power button (➁ in the illustration
below) to turn on the printer. Then release only the P power
button. When the printer starts the operation check, release
the b maintenance button.
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The printer prints an operation check page that includes your
printer’s ROM version information, the ink counter code, and a
nozzle check pattern. Below are sample printouts.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual test prints in color
(CMYK).

If the nozzle check page does not print satisfactorily, there is a
problem with the printer. This could be a clogged ink nozzle or a
misaligned print head. See the next section for details on cleaning
the print head. For information on aligning the print head, see
“Aligning the Print Head” on page 170.

Cleaning the Print Head

If you find that the printed image is unexpectedly faint or dots in
the printed image are missing, you may be able to solve these
problems by cleaning the print head, which ensures that the
nozzles are delivering ink properly.

You can clean the print head from your computer using the Head
Cleaning utility in the printer software, or from the printer itself
by using the printer’s control panel buttons.
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Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting

ink, clean the print head only if print quality declines; for example,
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head
needs to be cleaned. This saves ink.

❏ When theb error light is flashing or on, you cannot clean the print
head. Replace the appropriate ink cartridge first.

❏ Do not start the Head Cleaning or Nozzle Check utility while
printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility

Refer to the appropriate section below to use the Head Cleaning
utility.

For Windows users

Follow the steps below to clean the print head using the Head
Cleaning utility.

1. Make sure that the printer is on and the b error light is off.

Note:
If the b error light is flashing, you cannot clean the print head.
Replace the appropriate ink cartridge first.

2. Access the printer software, click the Maintenance tab, and
then click the Head Cleaning button.

3. Follow the on-screen instructions.

The P power light flashes while the printer performs the
cleaning cycle.
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c Caution:
Never turn off the printer while theP power light is flashing.
Doing so may damage the printer.

4. When the P power light stops flashing, click Print Nozzle 
Check Pattern in the Head Cleaning dialog box to confirm
that the head is clean and to reset the cleaning cycle.

Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints
in color.

If the nozzle check page does not print satisfactorily, you may
need to repeat the head cleaning and print the nozzle check
pattern again.

If print quality hasn’t improved after repeating this procedure
four or five times, turn the printer off and leave it alone overnight.
Then do the nozzle check again, and repeat the head cleaning if
necessary.

If the print quality still has not improved, one or both of your ink
cartridges may be old or damaged and may need to be replaced.
To replace an ink cartridge before it is empty, see “Replacing Ink
Cartridges” on page 197.
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If print quality remains a problem after replacing the ink
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend printing a few pages at least
once every month.

For Macintosh users

Follow the steps below to clean the print head using the Head
Cleaning utility.

1. Make sure that the printer is on and the b error light is off.

2. For users of Mac OS 8.1 or later (except Mac OS X), access the
printer software, click the Utility icon button, and then
click the Head Cleaning button.
For Mac OS X users, double-click the EPSON Printer Utility
icon in the Applications folder in Macintosh HD (by default
setting), select your printer, click OK in the Printer List
window, and then click the Head Cleaning button in the
Utility dialog box.

3. Follow the on-screen instructions.

The P power light flashes while the printer performs the
cleaning cycle.

c Caution:
Never turn off the printer while P power light is flashing.
Doing so may damage the printer.

4. When the P power light stops flashing, click the
Confirmation button in the Head Cleaning dialog box to print
a nozzle check pattern and to reset the cleaning cycle. Use the
check pattern to confirm that the head is clean.
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Below are nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints
in color.

If print quality has not improved after repeating this procedure
four or five times, turn the printer off and leave it alone overnight.
Then, do the nozzle check again, and repeat the head cleaning if
necessary.

If the print quality still has not improved, one or both of your ink
cartridges may be old or damaged and may need to be replaced.
To replace an ink cartridge, see “Replacing Ink Cartridges” on
page 197.

If print quality remains a problem after replacing the ink
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend printing a few pages at least
once every month.
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Using the control panel buttons

Follow the steps below to clean the print head using the control
panel buttons.

1. Make sure that the P power light is on and that the b error
light is off.

Note:
If the b error light is flashing or on, you cannot clean the print
head and this operation will start the ink cartridge replacement
procedure. If you do not want to replace an ink cartridge at this
moment, press the b maintenance button to return the print head
to its home position.

2. Hold down the b maintenance button for three seconds.

Note:
If you release the b maintenance button earlier than three seconds,
paper will feed. Press the b maintenance button again to eject paper,
then repeat step 1.
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The printer starts cleaning the print head and the P power
light begins flashing.

c Caution:
Never turn off the printer while theP power light is flashing.
Doing so may damage the printer.

3. When the P power light stops flashing, print a nozzle check
pattern to confirm that the head is clean and to reset the
cleaning cycle.

If print quality has not improved after repeating this procedure
four or five times, turn the printer off and leave it alone overnight.
Then, do the nozzle check again, and repeat the head cleaning if
necessary.

If the print quality still has not improved, one or both of your ink
cartridges may be old or damaged and may need to be
replaced.To replace an ink cartridge before it is empty, see
“Replacing Ink Cartridges” on page 197.

If print quality remains a problem after replacing the ink
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend printing a few pages at least
once every month.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal
banding, you may be able to solve this problem from your
computer using the Print Head Alignment utility in your printer
software. Refer to the appropriate section below.
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Note:
Do not start the Print Head Alignment utility while printing is in
progress; otherwise, your printout may be marred.

For Windows users

Follow the steps below to align the print head using the Print
Head Alignment utility.

1. Make sure that A4- or Letter-size plain paper is loaded in the
sheet feeder.

2. Access the printer software, click the Maintenance tab, and
then click the Print Head Alignment button.

3. Follow the on-screen instructions to align the print head.

For Macintosh users

Follow the steps below to align the print head using the Print
Head Alignment utility.

1. Make sure that A4- or Letter-size plain paper is loaded in the
sheet feeder.

2. For users of Mac OS 8.1 or later (except Mac OS X), access the
printer software, click the Utility icon button, and then
click the Print Head Alignment button.
For Mac OS X users, double-click the EPSON Printer Utility
icon in the Applications folder in Macintosh HD (by default
setting), select your printer, click OK in the Printer List
window, and then click the Print Head Alignment button in
the Utility dialog box.

3. Follow the on-screen instructions to align the print head.
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Chapter 7

Printing with PRINT Image Matching

How is PRINT Image Matching used?

This product supports PRINT Image Matching and PRINT Image
Matching II. When used in combination, PRINT Image Matching
or PRINT Image Matching II enabled digital still cameras, printers
and software help photographers to produce images more
faithful to their intentions.

The PRINT Image Matching function can be utilized if this
EPSON printer is used to print images from input devices, such
as digital cameras, loaded with the PRINT Image Matching
function. Print commands are attached to image data for printing
if photos are taken with an input device loaded with the PRINT
Image Matching function.

Note:
❏ See the relevant input device instruction manual for details

concerning the use of devices loaded with the PRINT Image
Matching function.

❏ Please check with the input device manufacturer to determine
whether it is loaded with the PRINT Image Matching function.

Media for which PRINT Image Matching is
enabled

PRINT Image Matching is enabled when the following media are
used:
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Plain Paper
EPSON Matte Paper Heavyweight
EPSON Photo Paper
EPSON Premium Glossy Photo Paper
EPSON Photo Quality Glossy Film
EPSON ColorLife Photo Paper
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Chapter 8

Exif Print

Exif Print

Exif2.2 is a new standard for digital cameras, is called "Exif Print."
This standard has been established to simplify the use of digital
photos.
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Chapter 9

Setting Up Your Printer on a Network

For Users of Windows Me, 98, and 95

This section tells you how to set up your printer so that other
computers on a network can use it.

First, you need to set up the printer as a shared printer on the
computer to which the printer is connected. Then, you must add
the printer to each computer that will access it through the
network.

Note:
This section describes how to use your printer as a shared printer on a
network. To connect your printer directly to a network without setting
it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the
steps below to configure the computer to which the printer is
connected.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click File and Print Sharing.
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4. Select the I want to be able to allow others to print to my 
printer(s) check box and click OK.

5. In the Network dialog box, click OK.

6. In the Control Panel, double-click the Printers icon.

Note:
❏ If a dialog box requesting the insertion of the Windows Me, 98

or 95 CD-ROM appears, insert the CD in the CD-ROM drive
and follow the on-screen instructions.

❏ If a dialog box requesting that you to restart your computer
appears, do so. Then, open the Printers folder, and continue
from step 7.

7. Select the icon for your printer in the Printers folder, then
click Sharing on the File menu.
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8. Select Shared As, then type the printer information as
required and click OK.

Accessing the printer through a network

To use your printer from other computers on a network, you must
first add the printer to each computer that will access it. Follow
the steps below.

Note:
Your printer must be set up as a shared resource on the computer to
which it is directly connected before you can access it from another
computer. For instructions, see “Setting up your printer as a shared
printer” on page 176.

1. Click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard
opens.

3. Click Next.
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4. Select Network printer, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that is directly
connected to the printer. Then, click the icon for the
appropriate printer.

7. Click OK and follow the on-screen instructions.
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Note:
To monitor the status of a shared printer, you must install EPSON
Status Monitor 3 on each computer that will access the printer. See
“Installing EPSON Status Monitor 3” on page 180 for
instructions.

Installing EPSON Status Monitor 3

To monitor the status of a printer accessed through a network,
you must install EPSON Status Monitor 3 on each computer that
will access the printer. Follow the steps below.

1. Insert the printer software CD in the CD-ROM drive. If the
Installer dialog box does not appear, double-click
SETUP.EXE in the CD-ROM.

2. Select Install Software, and click .

3. Click Advanced, select only EPSON Status Monitor3, and
then click Install.

4. Follow the on-screen instructions.

For Users of Windows XP, 2000 and NT 4.0

This section tells you how to set up your printer so that other
computers on the network can use it.

Note:
❏ This section is written for small network users only. If you are on a

large network and would like to share your printer, consult your
network administrator.

❏ To install software programs in Windows 2000 and NT 4.0, it is
necessary to log on as a user with administrative privileges (a user
who belongs to the Administrators group.)
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❏ To install software programs in Windows XP, it is necessary to log
on with a Computer Administrator account. You cannot install
software programs if you log on as a Limited account user.
After you install Windows XP, the user account is set as a Computer
Administrator account.

❏ The images that are provided in the following section pertain to
Windows 2000.

First, you need to set up the printer as a shared printer on the
computer to which the printer is connected. Then, you must add
the printer to each computer that will access it through the
network.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the
steps below to configure the computer to which the printer is
connected.

Note:
The screens shown in this section are from Windows 2000.

1. For users of Windows 2000 and NT 4.0, click Start, point to
Settings, and then click Printers.
For Windows XP users, click Start, Control Panel, Printers 
and Other Hardware, then Printers and Faxes.

2. Right-click the icon for your printer, then click Sharing.

3. Select Shared as (for Windows NT 4.0 users, select Shared),
and then type a name for the shared printer.
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Note:
Do not use spaces or hyphens in the printer name.

If you want Windows XP, 2000 or NT 4.0 to automatically
download printer drivers to computers that are running
different versions of Windows, click Additional Drivers and
select the environment and the operating systems for the
other computers. Click OK, then insert the printer software
CD in the CD-ROM drive. Select WINNT40 for Windows
NT4.0 or WIN9X for Windows Me, 98, or 95. Click OK to install
the additional drivers.

4. Click OK, or click Close if you installed additional drivers.

Accessing the printer through a network

To use your printer from other computers on a network, you must
first add the printer to each computer that will access it. Follow
the steps below.
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Note:
Your printer must be set up as a shared resource on the computer to
which it is directly connected before you can access it from another
computer. For instructions, see “Setting up your printer as a shared
printer” on page 181.

1. For users of Windows 2000 and NT 4.0, click Start, point to
Settings, and then click Printers.
For Windows XP users, click Start, and then click Control 
Panel. Next, click Printers and Other Hardware, and then
click Printers and Faxes.

2. Double-click the Add Printer icon. The Add Printer Wizard
opens.

3. Click Next.

4. Select Network printer, then click Next.

5. On the next screen, click Next.
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6. Double-click the icon of the computer that is directly
connected to the printer. Then, click the icon for the
appropriate printer.

7. Click Next and follow the on-screen instructions.

Note:
❏ Depending on the operating system and the configuration of the

computer to which the printer is connected, the Add Printer
Wizard may prompt you to install the printer driver from the
printer software CD-ROM. In this case, click the Have Disk
button and follow the on-screen instructions.

❏ To monitor the status of a shared printer, you must install
EPSON Status Monitor 3 on each computer that will access the
printer. See “Installing EPSON Status Monitor 3” on page 184
for instructions.

Installing EPSON Status Monitor 3

To monitor the status of a printer accessed through a network,
you must install EPSON Status Monitor 3 on each computer that
will access the printer. Follow the steps below.
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1. Insert the printer software CD in the CD-ROM drive. If the
Installer dialog box does not appear, double-click
SETUP.EXE in the CD-ROM.

2. Select Install EPSON Software, and click .

3. Click Advanced, select only EPSON Status Monitor3, and
then click Install.

4. Follow the on-screen instructions.

For Macintosh Users

This section tells you how to set up the printer so that you can use
it on an AppleTalk network. By setting up your printer as a shared
printer, your local printer is connected to the network and can be
used by other computers.

Note:
This feature is not available with Mac OS X.

First, you need to set up the printer as a shared printer on the
computer to which the printer is connected. Then, you must
specify the network path to the printer from each computer that
will use it, and install the printer software on those computers.

Setting up your printer as a shared printer

To share a printer with other computers on an AppleTalk
network, follow the steps below to configure the computer to
which the printer is connected.

1. Turn on the printer.
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2. Choose Chooser from the Apple menu and click the icon for
your printer. Then, select the port to which the printer is
connected.

3. Click Setup. The Printer Sharing Setup dialog box opens.

4. Select the Share this Printer check box, then type the printer
name and password information as necessary.

5. Click OK. The name of the shared printer appears in the port
list in the Chooser.

6. Close the Chooser.
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Accessing the printer through a network

To access your printer from other computers on a network, follow
the steps in this section for each computer that will access the
printer.

1. Turn on your printer.

2. Install the printer software from the printer software
CD-ROM.

3. Choose Chooser from the Apple menu. Then, click the
appropriate printer icon and select the printer port that you
want to use from the Select a printer port list.

Note:
Only printers that are connected to your current AppleTalk zone
are available.
187 Setting Up Your Printer on a Network



9

9

9

9

9

9

9

9

9

9

9

9

If the following dialog box appears, enter the password for
the printer, then click OK.

4. Select the appropriate Background Printing radio button to
turn background printing on or off.

5. Close the Chooser.
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Chapter 10

Increasing the Print Speed

General tips

Just as printing at a high resolution requires more processing time
than printing at a low resolution, printing in color takes longer
than printing in black-and-white because the volume of data in a
color document is much greater. For this reason, it is important
to be selective in your use of color if you also require a fast print
speed.

However, even if your document requires the highest resolution
and extensive use of color—for example, when you are printing
a camera-ready composite that includes color photographs—it
may still be possible to optimize the print speed by adjusting other
printing conditions. Keep in mind that changing some conditions
to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Menu or
dialog
box

Printer
software
settings

Paper &
Quality
Options
(Windows),
Print Quality
(Macintosh)

Economy,
Normal

Photo Advanced
dialog box

High Speed On Off

Finest Detail
(Macintosh)

Off On
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The table below shows the factors related to print speed only.

* Varies depending on the printer software and application that you are using.

** Grayscale means using black ink only to print varying shades of gray, ranging
from pure black to pure white.

Data
characteristic
s

Image size Small Large –

Resolution Low High

Print speed Faster Slower Menu or
dialog box

Printer
software
settings

Ink
(Macintosh)

Black Color Print dialog
box

Flip Horizontal*
(Macintosh)

Off On Advanced
dialog box

Edge
smoothing*

Off On Advanced
dialog box

Collate* Off On Page
Layout
menu
(Windows),
Layout
dialog box
(Macintosh)

Reverse Order* Off On

Data
characteristic
s

Variety of
colors

Grayscale** Full color –

Hardware
resources

System speed Faster Slower –

HDD free
space

Large Small

Memory free
space

Large Small

Software
status

Running
applications

One Many –

Virtual memory Not in use In use
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Using the Speed & Progress dialog box
(Windows only)

Windows users can make certain print speed settings in the Speed
& Progress dialog box. Click the Speed & Progress button on
your printer software’s Utility menu. The following dialog box
appears.

The settings related to print speed are listed below.

Note:
The specific features available in the printer software vary depending on
the printer model and the version of Windows that you are using.

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk
space as a cache when printing multiple copies of your document.
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EPSON Printer Port (Windows Me, 98, 95 only)

For printer models that use the parallel port, select this check box
to enable the EPSON printer port, which is optimized for EPSON
printers, instead of the Windows default printer port. This speeds
up the data transfer rate to EPSON printers. Parallel port users
can further increase print speed by enabling DMA transfer, as
explained below.

Enabling DMA transfer

If your computer has a parallel port which supports ECP mode,
you can enable DMA transfer to speed up printing. See your
computer manual to determine if it supports ECP mode and DMA
transfer.

To determine whether you need to enable DMA transfer, compare
the message below the EPSON Printer Port check box to this table,
and take the recommended action.

Message Action

High Speed (DMA)
Transfer enabled.

DMA transfer is already enabled. Click OK
to close the dialog box.

For higher data transfer
rates, use DMA Transfer.

Follow the steps below this table to enable
DMA transfer.
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If you want to enable DMA transfer, follow the steps below.

1. Double-click the My Computer icon on your desktop and then
Control Panel.

2. Double-click the System icon and click the Device Manager
tab.

3. Double-click the Ports (COM & LPT) icon and then the LPT1 
icon. If your printer is connected to a port other than LPT1,
double-click the appropriate port icon.

(No message) Your system's parallel port setting does not
allow DMA transfer. However, if you change
the parallel port setting to ECP or Enhanced
using your computer's BIOS Setup program,
you may be able to use DMA transfer.
Consult your computer manual or
computer manufacturer for instructions.
Once you change the parallel port setting,
follow the steps below this table to enable
DMA transfer.

Note:
Before you run the BIOS Setup program,
uninstall the printer software using
Add/Remove Programs in the Control
Panel. After running the BIOS Setup
program, reinstall the printer software.

Message Action
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4. Click the Resources tab, then clear the Use automatic 
settings check box. Write down the Input/Output Range
settings shown in the resource settings box.

5. Select a basic configuration setting from the Setting based on
list that uses the same Input/Output Range settings as those
you wrote down in Step 4, and make sure that the Direct
Memory Access channel and Interrupt Request numbers are
allocated and displayed. Confirm also that the Conflicting
device list text box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether
DMA transfer has been enabled.

Note:
You may not be able to use DMA transfer on some computers even
after you make the settings explained above. Consult your computer
maker for information on the DMA transfer capability of your
computer.
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Using Port Configuration (Windows NT 4.0 only)

Note:
Port settings are complicated and should only be made by an experienced
user with administrative privileges.

If your computer has a parallel port that supports ECP mode, you
can make certain print speed settings in the Port Configuration
dialog box. Before making settings, make sure that ECP mode has
been selected in your computer settings. For details about ECP
mode, see your computer manual.

To access the Port Configuration dialog box, click the Start button,
point to Settings, and click Printers. Then, select your printer and
click Properties on the File menu. The printer driver opens. Click
the Ports tab, then click Configure Port. The following dialog box
appears.

Click the LPT port tab for the port to which your printer is
connected, then click the Port Configuration button.
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Note:
If your printer is connected to LPT1, only the LPT1 tab is available.

The available settings are as follows:

Resource settings (IRQ and DMA)

If you have connected your printer to LPT2 or LPT3, making IRQ
and DMA settings here may speed up printing. Click Change 
setting and input the same configuration numbers for IRQ and
DMA which you have made with your expansion board. See your
computer documentation to determine the settings for IRQ and
DMA.

Use DMA transfer

Using DMA transfer to send print data to the computer may help
speed up printing. If the Use DMA Transfer check box is not
enabled, you must first enable DMA transfer in your computer
settings. For details, see your computer documentation.
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Chapter 11

Replacing Ink Cartridges

Introduction

This printer uses ink cartridges equipped with IC chips. The IC
chip accurately monitors the amount of ink used by each
cartridge, so even if a cartridge is removed and later reinserted,
all of its ink can be used. However, some ink is consumed each
time the cartridge is inserted because the printer automatically
checks reliability.

You can replace an ink cartridge using the printer’s control panel
or using the Status Monitor utility. Refer to the appropriate
section below for instructions.

Using the Printer's Control Panel Buttons

The printer’s indicator lights will inform you when it is time to
obtain a replacement ink cartridge and when it is time to replace
an empty cartridge.
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This table describes the status of the lights on your printer and
the actions you need to take.

O = on, F = flashing

To find out which ink cartridge is empty, check EPSON Status
Monitor 3 (for Windows) or EPSON StatusMonitor (for
Macintosh). You can also tell which cartridge is empty by
checking the speed at which the b error light flashes when the
print head moves to the ink cartridge replacement position. See
the table below.

Lights Action

F b Obtain a replacement black (T026) or color (T027) ink
cartridge.

O b Replace the empty black or color ink cartridge.

Lights Action

F b Replace the black ink cartridge if the b error light flashes
at the same speed as the power light.

F b Replace the color ink cartridge if the b error light flashes
at twice the speed of the P power light.

O b Replace both the black and the color ink cartridges if this
light remains on.
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w Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there
may be some ink around the ink supply port. If ink gets on
your skin, wash the area thoroughly with soap and water. If
ink gets into your eyes, flush them immediately with water.
If discomfort or vision problems remain after a thorough
flushing, see a doctor immediately.

c Caution:
❏ EPSON recommends the use of genuine EPSON ink

cartridges. Other products not manufactured by EPSON
may cause damage to your printer not covered by EPSON's
warranties.

❏ Leave the old cartridge installed in the printer until you have
obtained a replacement; otherwise, ink remaining in the print
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the
amount of ink remaining using an IC chip on the ink
cartridge. Even if the cartridge is refilled, the amount of ink
remaining will not be recalculated by the IC chip and the
amount of ink available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if

the other cartridge still contains ink. Before printing, replace the
empty cartridge.

❏ In addition to the ink used during document printing, ink is
consumed during the print head cleaning operation, during the
self-cleaning cycle which is performed when the printer is turned
on, and during ink charging when the ink cartridge is installed in
the printer.
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For more information about ink cartridges, see “When handling
the ink cartridges” on page 8.

To replace an ink cartridge using the e ink cartridge replacement
button, follow the steps below.

1. Make sure that the printer is on. The P power light should be
on, but not flashing.

2. Lower the output tray, then open the printer cover.

3. Press the e ink cartridge replacement button. The print head
moves to the ink cartridge replacement position, theP power
light begins to flash, and the b error light begins to flash or
remains on. To find out which cartridge requires replacing,
see “Using the Printer's Control Panel Buttons” on page 197,
or check EPSON Status Monitor 3 (for Windows) or EPSON
StatusMonitor (for Macintosh).

c Caution:
Do not move the print head by hand, as this may damage the
printer. Always press the e ink cartridge replacement
button to move it.
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4. Lift up the ink cartridge clamp as far as it will go. The cartridge
rises partly out of the cartridge holder.

5. Lift the cartridge out of the printer and dispose of it properly.
Do not take the used cartridge apart or try to refill it.

The illustration shows color ink
cartridge replacement. To
replace the black ink cartridge,
lift up only the smaller clamp on
the left.
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6. Remove the new ink cartridge from its protective bag. Next,
remove only the yellow tape seal from the cartridge. Do not
touch the green chip on the side of the cartridge.

black ink cartridge (T026) color ink cartridge (T027)
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c Caution:
❏ You must remove the yellow tape seal from the cartridge

before installing it; otherwise, the cartridge will become
unusable and you will be unable to print.

❏ If you have installed an ink cartridge without removing
the yellow tape seal, you must remove the cartridge and
install a new one. Prepare the new cartridge by removing
the yellow tape seal, then install it in the printer.

❏ Do not remove the blue portion of the tape seal from the
top of the cartridge; otherwise, the print head may become
clogged and be unable to print.

❏ Do not remove the tape seal from the bottom of the
cartridge; otherwise, ink will leak.

❏ Do not touch the green IC chip on the side of the
cartridge; otherwise, normal operation and printing may
not be possible.

❏ If an ink cartridge should be removed temporarily from
the printer, be sure to protect the ink supply area of the
ink cartridge from dirt and dust. Store the ink cartridge
in the same environment as the printer. When storing
the cartridge, be sure that it stands as shown in the
illustration above (the label that identifies the color of the
ink cartridge should be displayed on the top of the
cartridge). The valve in the ink supply port is designed
to contain any excess ink that may be released. However,

Do not touch this part.
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careful handling is recommended. Do not touch the
supply port of the ink cartridge or its surrounding area.

❏ Be sure to always install an ink cartridge into the printer
immediately following the removal of an old ink
cartridge. Failure to promptly install the ink cartridge
may cause the print head to dry out and render it unable
to function properly.

7. Align the tabs on the ink cartridge so that they are resting on
the tabs protruding from the base of the opened ink cartridge
clamp. Push the clamps down until they lock firmly into place.

8. Lower the ink cartridge clamp until it locks into place.

The illustration shows color ink
cartridge replacement. To
replace the black ink
cartridge, replace only the
cartridge held by the smaller
clamp on the left.
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c Caution:
After you remove an ink cartridge from the printer, insert a
new one immediately. If no cartridge is present, the print head
may dry out and become unable to print.

9. Close the printer cover.

10. Press the e ink cartridge replacement button. The printer
moves the print head and begins charging the ink delivery
system. This process takes about thirty seconds to complete.
When the ink charging process is finished, the printer returns
the print head to its home position, the P power light stops
flashing and remains on, and the b error light goes out.

c Caution:
The P power light continues to flash while the printer is
charging ink. Never turn off the printer while this light is
flashing. Doing so can result in incomplete charging of ink.

Using the Status Monitor

You can monitor the remaining ink levels from your computer
and view on-screen instructions for replacing a low or empty ink
cartridge using EPSON Status Monitor 3 (for Windows) or
EPSON StatusMonitor (for Macintosh).
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When an ink cartridge is low or empty, click How to in the EPSON
Status Monitor window. Follow the on-screen instructions to
replace the cartridge.

For more information on using EPSON Status Monitor, see
“Using EPSON Status Monitor 3” on page 151 for Windows, or
“Using EPSON StatusMonitor” on page 153 for Macintosh.

Checking the Ink Supply

For Windows users

You can check the amount of ink remaining in the ink cartridges
using EPSON Status Monitor 3 or the Progress Meter. Refer to the
appropriate section below for details.

EPSON Status Monitor 3

Access EPSON Status Monitor 3 in one of the following ways.

❏ Double-click the printer-shaped shortcut icon on your
Windows taskbar. To add a shortcut icon to the taskbar, see
“Monitoring Preferences” on page 82.

❏ Open the printer software, click the Maintenance tab, then
click the EPSON Status Monitor 3 button.
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A graphic display showing the amount of ink remaining appears.

Note:
For the color ink cartridge, the color with the least amount of ink
remaining determines the level that is displayed for all of the colors in
the cartridge.

Progress Meter

The Progress Meter dialog box appears automatically when you
send a print job to the printer. You can check the amount of ink
remaining from this dialog box.
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For Macintosh users

You can check the amount of ink remaining in the ink cartridges
using the StatusMonitor. Follow the steps below.

For users of Mac OS 8.1 or later (except Mac OS X)

1. Click Print or Page Setup on the File menu of your
application. The Print dialog box appears.

2. Click the Utility icon button, then click the
EPSON StatusMonitor button in the Utility dialog box.

A graphic displaying the amount of ink remaining appears.

Note:
❏ The graphic displays the amount of ink that was remaining

when EPSON StatusMonitor was first opened. To update the
ink-level information, click Update.

❏ For the color ink cartridge, the color with the least amount of
ink remaining determines the level that is displayed for all of
the colors in the cartridge.
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For Mac OS X users

1. Double-click Macintosh HD (by default setting), double-click
the Applications folder, and then double-click the EPSON 
Printer Utility icon. The Printer List window appears.

2. Select your printer, and then click OK. The EPSON Printer
Utility dialog box appears.

3. Click the EPSON StatusMonitor button. The StatusMonitor
dialog box appears.

Note:
❏ The graphic displays the amount of ink that remained when EPSON

StatusMonitor was first opened. To update the ink-level
information, click Update.

❏ For the color ink cartridge, the color with the least amount of ink
remaining determines the level that is displayed for all of the colors
in the cartridge.
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Updating and Uninstalling Software

See this section when upgrading your Windows operating
system, updating the printer software under Windows Me, 2000
XP or NT 4.0, or when uninstalling the printer driver from
Windows or Macintosh.

Updating to Windows Me or 98

If you have upgraded your computer’s operating system from
Windows 95 to Windows Me or 98, you must uninstall your
printer software, and then install it again. See “Uninstalling the
printer driver” on page 210 for instructions.

Updating the printer software under
Windows Me, XP, 2000 or NT 4.0

When you update the printer software under Windows Me, XP,
2000 or NT 4.0, be sure to uninstall the previous printer software
before you install the new software. Installing over the existing
printer software results in a failure to update. See “Uninstalling
the printer driver” on page 210 for details on uninstalling the
printer software.

Uninstalling the printer driver

For Windows

Note:
❏ To uninstall software programs under Windows 2000 and NT 4.0,

it is necessary to log on as a user with administrative privileges
(a user who belongs to the Administrators group.)
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❏ To uninstall software programs in Windows XP, it is necessary to
log on with a Computer Administrator account. You cannot
uninstall software programs if you log on as a Limited account user.

1. Turn off the printer and disconnect the cable from the printer.

2. For users of Windows Me, 98, 95, 2000 and NT 4.0, click the
Start button, select Settings, and then choose Control Panel.
For Windows XP users, click the Start button, and then choose
Control Panel.

3. Double-click the Add/Remove Programs icon and select
EPSON Printer Software from the list. Then, click
Add/Remove. For Windows XP and 2000, click
Change/Remove.

4. Select the EPSON Stylus Photo 830 Series icon and click OK.

5. Click OK.

Note:
If you are using the USB port to connect the printer in Windows Me or
98, you need to uninstall an additional USB component. Select EPSON 
USB Printer Device from the list in the Add/Remove Programs utility,
click Add/Remove, and then click OK when a message prompts you to
restart the computer. If EPSON USB Printer Device does not appear
in the Add/Remove Programs list, double-click EPUSBUN.EXE on the
printer software CD-ROM, and then follow the on-screen instructions.

For Macintosh

Note:
You cannot uninstall the printer driver under Mac OS X.

1. Turn on your Macintosh and insert the software CD in the
CD-ROM drive. The EPSON printer software disk will open
automatically.
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2. If separate folders containing installer icon for several
languages appear, double-click the folder for your preferred
language. Double-click the Installer icon in Disk 1 folder
inside Disk Package folder.

3. After the initial screen, click Continue. The following dialog
box appears.

4. Select Uninstall from the pull-down menu at the top left, and
then click Uninstall.
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Transporting the Printer

If you need to transport your printer, carefully prepare and repack
it as described below using the original box (or a similar box that
the printer fits snugly into) and packing materials. Follow the
steps below.

c Caution:
❏ When storing or transporting the printer, don’t tilt it, put it

vertically or turn it upside down. Otherwise ink may leak
from the cartridge.

❏ Leave the ink cartridges installed when you transport the
printer. Transporting the printer with the cartridges
removed can damage the printer.

1. Open the printer cover and make sure that the print head is
in the home (far right) position. If not, turn on the printer and
wait until the print head returns to the home position. Close
the printer cover, and then turn off and unplug the printer.

2. Disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder and remove the paper
support.
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4. Open the printer cover again. Secure the ink cartridge holder
to the printer with the protective material tape as shown
below, and then close the printer cover.

5. Push in the output extension tray, and then raise the output
tray.

6. Attach the protective materials to both sides of the printer.

7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.
214



Chapter 12

Troubleshooting

Diagnosing the Problem

If you are connecting via the USB interface and are having
difficulty printing, the problem may be related to your USB
connection. Refer to “Correcting USB Problems” on page 239 for
details.

If your problem is not USB related, troubleshooting printer
problems is best handled in two easy steps: first diagnose the
problem, then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most
common problems is provided by online problem solving, the
printer’s control panel, the EPSON Status Monitor utility, or by
running a printer operation check. Refer to the appropriate
section below.

If you have a specific problem relating to print quality, a printout
problem not related to print quality, or a paper feeding problem,
or if the printer does not print at all, refer to the appropriate
section in this chapter.

To solve a problem, you may need to cancel printing. For details,
see “Cancelling Printing” on page 245.

Online problem solving

You can use online problem solving to diagnose and solve most
of the problems you may encounter. Refer to the appropriate
section below.
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For Windows users

The Problem Solver HTML manual provides you with tips to help
solve any problems you may encounter when using your printer.

If you encounter a problem, access the Problem Solver in one of
the following ways:

❏ From the Windows Start menu

Click Start, point to Programs (for users of Windows Me, 98,
95, 2000 and NT 4.0) or All Programs (for Windows XP users),
then to EPSON, and then click ESP830 Problem Solver.

❏ From Status Monitor 3

Click Technical Support in the Status Monitor 3 dialog box.

❏ From your printer software

Click Technical Support on the Main menu of the printer
software.

If you cannot solve your problem using the Problem Solver,
contact Technical Support for assistance by clicking the Technical 
Support Web Site link in the Problem Solver.

For Macintosh users

EPSON's Technical Support Web Site provides help with
problems that cannot be solved using the troubleshooting
information in your printer documentation.

To access the Web site from the printer software CD-ROM, insert
the CD in the CD-ROM drive and double-click the EPSON icon,
then select Technical Support Web Site and click .
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Error indicators

You can identify many common printer problems using the lights
on your printer’s control panel. If your printer stops working and
the lights are on or flashing, use the following table of panel light
patterns to diagnose the problem, then try the recommended
solution. If the status of the power light is not shown, it is on or
flashing.

Lights Problem and Solution

O b Paper out

No paper is loaded in the
printer.

Load paper in the sheet feeder,
then press the b maintenance
button. The printer resumes
printing and the light goes out.

O b Paper jam

Paper has jammed in the
printer.

Press the b maintenance button
to eject the jammed paper. If the
error does not clear, open the
printer cover and remove all of the
paper inside, including any torn
pieces. Then, reload the paper in
the sheet feeder and press the
b maintenancebuttonto resume
printing.

F b Ink low

The black or color ink
cartridge is nearly
empty.

Obtain a replacement black
(T026) or color (T027) ink cartridge.
To determine which cartridge is
nearly empty, check the ink level
using EPSON Status Monitor 3
(Windows) orEPSON StatusMonitor
(Macintosh).
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O = on, N = off, F = flashing

O b Ink out

The black or color ink
cartridge is empty or not
installed.

Replace the black (T026) or color
(T027) ink cartridge with a new
one. See “Replacing Ink
Cartridges” on page 197 for
details.

Wrong cartridge

The installed black or
color ink cartridge
cannot be used by this
printer.

Use the appropriate black (T026)
or color (T027) ink cartridge. See
“Replacing Ink Cartridges” on
page 197 for details.

O P
O b

Incorrectly installed ink cartridge

The black or color ink
cartridge is not installed
correctly.

If the print head is at the home
position, press the e ink cartridge
replacement button to move the
print head to the ink cartridge
replacement position. Lift up the
ink cartridge clamp, then remove
and reinsert the ink cartridge. Then
continue with ink cartridge
installation.

If the print head is at the ink
cartridge replacement position,
lift up the ink cartridge clamp, then
remove and reinsert the ink
cartridge. Then continue with ink
cartridge installation.

N P
O b

Carriage error

The print head carriage
is obstructed by jammed
paper or other foreign
material and cannot
return to the home
position.

Turn off the printer. Open the
printer cover and remove any
paper or other obstructions from
the paper path by hand. Then,
turn the printer back on.

If the error does not clear, contact
your dealer.

F P
F b

Unknown printer error

An unknown printer error
has occurred.

Turn off the printer and contact
your dealer.
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EPSON Status Monitor

The EPSON Status Monitor utility provides status messages and
a graphic display showing the current status of the printer.

If a problem occurs while printing, an error message appears in
the Progress Meter window.

When the ink is out, click How To in the EPSON Status Monitor
or Progress Meter window and EPSON Status Monitor will lead
you step-by-step through the cartridge replacement procedure.

Running a printer operation check

If you are unable to determine the source of the problem,
performing a printer operation check can help you determine
whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. If you use the parallel interface, make sure both the printer
and computer are turned off. If you use the USB interface,
make sure the PC is on and the printer is turned off.

2. Disconnect the cable from the printer’s interface connector.

If you use the parallel interface, unlock the wire clips on both
sides of the interface connector, remove the ground connector
if necessary, and then disconnect the cable from the printer’s
interface connector.
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If you use the USB interface, make sure that your PC is on
when connecting the cable; otherwise, the PC may not
recognize the printer.

3. Make sure that A4 or Letter size paper is loaded in the sheet
feeder.
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4. Hold down the b maintenance button and press the
P power button to turn on the printer. Then, release only the
P power button. When the printer starts the operation check,
release the b maintenance button.

The printer prints an operation check page which includes the
version of your printer’s ROM, the ink counter code, and a nozzle
check pattern.

Compare the quality of the printed test page with the sample
shown below. If there are no print quality problems, the printer
itself is fine and the problem probably lies with the printer
software settings, the application settings, the interface cable (be
sure to use a shielded cable), or the computer itself.

The above sample is in black and white, but the actual check page prints
in color (CMYK).
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If the test page does not print satisfactorily, there is a problem
with the printer. For example, if bands appear in the check pattern
as shown below, this could mean a clogged ink nozzle or a
misaligned print head.

The above sample is in black and white, but the actual check pattern prints
in color.

Print Quality Problems

If you are having print quality problems, try the solutions offered
in this section.

Horizontal banding

Try one or more of these solutions:

❏ Make sure that the printable side of the paper is face up in the
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink
nozzles.

❏ Clear all customized settings, and then select the Text & 
Image setting under Quality Type on your printer software’s
Main menu (Windows) or select the Automatic setting under
Mode in the Print dialog box (Macintosh).
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❏ Check the b error light. If the light is flashing, replace the
appropriate ink cartridge.
See “Replacing Ink Cartridges” on page 197.

❏ Make sure that the Minimize Margins setting is not selected
under More Options in the Page Layout menu (Windows) or
that the Maximum setting is not selected as the Printable Area
in your printer software (Macintosh). When this setting is
selected, banding may occur in the expanded area.

❏ Make sure that the Media Type selected in the printer
software is appropriate for the type of media loaded in the
printer.

❏ Make sure the MicroWeave check box is selected when
available in the Advanced dialog box (Macintosh).
& For Macintosh users, “Making Advanced settings” on page
91“Making Advanced settings” on page 91

Vertical misalignment or banding

Try one or more of these solutions:

❏ Make sure that the printable side of the paper is face up in the
sheet feeder.

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 170

❏ Clear the High Speed check box in the Advanced dialog box.

❏ Run the Head Cleaning utility to clear any clogged ink
nozzles.
& “Cleaning the Print Head” on page 164

❏ Make sure that the Media Type setting selected in the printer
software is appropriate for the type of media loaded in the
printer.
223 Troubleshooting



12

12

12

12

12

12

12

12

12

12

12

12

    
❏ Make sure that the MicroWeave check box is selected when
available in the Advanced dialog box (Macintosh).

Color gaps

Try one or more of these solutions:

❏ Make sure that your paper is not damaged, dirty, or too old.
Also, make sure that the printable side of the paper is face up
in the sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink
nozzles.

❏ Check the b error light. If the light is flashing, replace the
appropriate ink cartridge.
& See “Replacing Ink Cartridges” on page 197.

❏ Adjust the color settings in your application or in your printer
software’s Advanced dialog box.
& For Windows users, “Making Advanced settings” on page
62
& For Macintosh users, “Making Advanced settings” on page
91

❏ Clear all customized settings, and then select the Text &
Image setting under Quality Type on your printer software’s
Main menu (Windows) or select the Automatic setting under
Mode in the Print dialog box (Macintosh).

❏ Make sure that the Media Type setting selected in the printer
software is appropriate for the type of media that is loaded in
the printer.
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Incorrect or missing colors

Try one or more of these solutions:

❏ Change the Ink setting in your printer software to Color.

❏ Adjust the color settings in your application or in your printer
software’s Advanced dialog box.

❏ Run the Head Cleaning utility.
& “Cleaning the Print Head” on page 164.
If colors are still incorrect or missing, replace the color ink
cartridge. If the problem persists, replace the black ink
cartridge.
& See “Replacing Ink Cartridges” on page 197 for details.

❏ Do not use ink cartridges beyond the expiration data printed
on the cartridge package. Also, if the printer has not been used
for a long time, replace the ink cartridges.
& See “Replacing Ink Cartridges” on page 197.

Blurry or smeared printout

Try one or more of these solutions:

❏ Make sure that you are using the appropriate printer driver
for your printer.

❏ Use only paper recommended by EPSON.

❏ Make sure that the printer is on a flat, stable surface that
extends beyond the printer base in all directions. The printer
will not operate properly if it is tilted.

❏ Make sure that your paper is not damaged, dirty, or too old.
Also, make sure that the printable side of the paper is face up
in the sheet feeder.
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❏ Make sure that your paper is dry and that the printable side
is facing up. Also, make sure that you are using an acceptable
paper type.
& “Paper” on page 259

❏ Clear all customized settings, and then select the Text & 
Image setting under Quality Type on your printer software’s
Main menu (Windows) or select the Automatic setting under
Mode in the Print dialog box (Macintosh).

❏ If the paper is curled toward the printable side, flatten it or
curl it slightly toward the opposite side.

❏ Remove each sheet from the output tray as it is printed,
especially if you are using transparencies.

❏ If you are printing on glossy media or transparencies, place a
support sheet (or a sheet of plain paper) beneath the stack. Or,
load only one sheet at a time.

❏ Run the Head Cleaning utility.
& “Cleaning the Print Head” on page 164

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 170
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❏ Load and eject dry paper several times. If the problem
persists, ink may have leaked inside the printer, so wipe the
inside of the printer with a soft, clean cloth.

w Warning:
Be careful not to touch the gears inside the printer.

Wipe here
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c Caution:
Be careful not to wipe the carriage shaft.

Print quality does not improve after head
cleaning

If the quality of your printouts remains poor even after repeatedly
cleaning and aligning the print head, one or some of the ink
cartridges may be old or damaged and should be replaced.

To replace an ink cartridge before the Status Monitor notifies you
that the cartridge is empty.
& “Replacing Ink Cartridges” on page 197See “Replacing Ink
Cartridges” on page 197.

Printout Problems Not Related to Print Quality

If one of the following problems has occurred, try the solutions
listed for the problem.

❏ Incorrect or garbled characters

❏ Incorrect margins
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❏ Inverted image

❏ Blank pages print

❏ Printout has smears on the bottom edge

❏ Printing is too slow

Incorrect or garbled characters

Try one or more of these solutions:

❏ Make sure that you are using the appropriate printer driver
for your printer.

❏ Select your printer as the default printer in Windows.

❏ Windows Me, 98 and 95 users can clear any stalled print jobs
from the Spool Manager
& “Using EPSON Spool Manager” on page 246

❏ Turn off the printer and computer. Make sure that the
printer’s interface cable is securely plugged in.

❏ If you are using Windows NT 4.0, try uninstalling the EPSON
Printer Port. Click Start, point to Programs and then to
EPSON Printers, then click EPSON Printer Port Uninstall.
Follow the on-screen instructions.

Incorrect margins

Try one or more of these solutions:

❏ Check the margin settings in your application. Make sure that
the margins are within the printable area of the page.
& “Paper” on page 259
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❏ Check the settings on the Main menu (Windows) or in the
Page Setup dialog box (Macintosh). Make sure the settings are
appropriate for the paper size you are using.

Inverted image

Clear the Flip Horizontal check box in the printer software
(Macintosh), or turn off the “Mirror” setting in your application.
For instructions, see online help for the printer software or for
your application.

Macintosh users can refer to “Making Advanced settings” on
page 91 for details.

Blank pages print

Try one or more of these solutions:

❏ Make sure that you are using the appropriate printer driver
for your printer.

❏ Windows users can make sure that their printer is selected as
the default printer.

❏ Check the settings on the Main menu (Windows) or in the
Page Setup dialog box (Macintosh). Make sure the settings are
appropriate for the paper size you are using.

❏ Run the Head Cleaning utility to clear any clogged nozzles.
& “Cleaning the Print Head” on page 164

After trying one or more of these solutions, run a printer operation
check to check your results.
& “Running a printer operation check” on page 219
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Printout has smears on the bottom edge

If the paper is curled toward the printable side, flatten it or curl it
slightly toward the opposite side.

Printing is too slow

Try one or more of these solutions:

❏ Make sure that the Media Type setting in your printer
software is correct.

“Media Type Settings” on page 143

❏ For Windows, select the Text setting under Print Quality on
your printer software’s Main menu.
For Macintosh, select the Automatic setting under Mode in
the Print dialog box (Macintosh), and then move the slider to
Speed.
& For Windows users, “Quality Type” on page 56
& For Macintosh users, “Using the Automatic mode” on page
88

❏ Close any applications that you are not using at the moment.

❏ If you upgraded from Windows 95 to Windows 98, uninstall
the printer software using Add/Remove programs in the
Control Panel in Windows, then install the software again.

❏ For printer models that use the parallel port, you can enable
DMA transfer if your computer supports ECP mode.
& “Enabling DMA transfer” on page 192
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Paper Does Not Feed Correctly

If one of the following problems has occurred, try the solutions
listed for that problem.

❏ Paper does not feed

❏ Multiple pages feed

❏ The paper jams

❏ Paper is not ejected fully or is wrinkled

❏ Paper does not feed correctly when using the double-sided
printing feature

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with
the paper for more information.

❏ The paper stack fits under the tabs inside the edge guides and
does not exceed the loading limit indicated by the arrow mark
on the left edge guide.

❏ The number of sheets in the paper stack does not exceeded
the limit specified for the media.

“Single Sheets” on page 131
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❏ Paper is not jammed inside the printer. If it is, remove the
jammed paper.

❏ The ink cartridges are not empty. Replace cartridges as
necessary.
& “Print quality does not improve after head cleaning” on
page 228

After trying the solutions above, load the paper again. Make sure
that you follow any special loading instructions that came with
your paper. See also “Paper Handling” on page 131.

“Single Sheets” on page 131

Multiple pages feed

❏ Make sure that the paper stack fits under the arrow mark
located on the inside surface on the left edge guide.

❏ Make sure that the paper is loaded under the tabs inside the
edge guides.

❏ Make sure that the left edge guide is flush against the left edge
of the paper.

❏ Make sure that the paper is not curled or folded. If it is, flatten
it or curl it slightly toward the opposite side.

❏ Remove the stack of paper and make sure that the paper is
not too thin.
& “Paper” on page 259
Fan the edges of the stack to separate the sheets, then reload
the paper.
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❏ If too many copies of a document are being printed, check the
Copies setting on the printer software’s Page Layout menu
(Windows) or in the Print dialog box (Macintosh) and in your
application.
& For Windows users, “Copies” on page 70
& For Macintosh users, “Making Settings in the Print Dialog
Box” on page 86

Paper jams

Press theb maintenance button to eject the jammed paper. If the
error does not clear, open the printer cover and remove all of the
paper inside, including any torn pieces. Then, reload the paper in
the sheet feeder and press b maintenance button to resume
printing.

Note:
If you cannot remove a foreign object easily by yourself, do not use force
and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ The paper is of high quality, loaded with the printable side up.

❏ The paper stack was fanned before loading.

❏ The paper stack is loaded under the tabs inside the edge
guides.

❏ The paper is not loaded above the arrow on the left edge
guide.

❏ The number of sheets in the paper stack does not exceed the
limit specified for that media.
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Single Sheets

❏ The left edge guide is adjusted to fit your paper.

❏ The printer is on a flat, stable surface that extends beyond the
printer base in all directions. The printer will not operate
properly if it is tilted.

Paper is not ejected fully or is wrinkled

Try one or more of these solutions:

❏ If the paper does not eject fully, press the b maintenance
button, then open the printer cover and remove the paper.
Also, check the Paper Size setting in your application or
printer software.

❏ If the paper is wrinkled when it comes out, it may be damp
or too thin. Load a new stack.

Note:
Store any unused paper in its original package in a dry area.
& “Paper” on page 259

Printer Does Not Print

If the printer does not print, see if the status of your printer’s lights
is listed below, then try the solutions listed.

❏ All lights are off

❏ Lights came on and then went out
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❏ Only the power light is on

❏ The b error light is flashing or on

❏ One of the ink out lights is flashing or on

❏ Ink out lights are on and the other lights are flashing

All lights are off

Try one or more of these solutions:

❏ Press the P power button to make sure that the printer is on.

❏ Turn off the printer and make sure that the power cord is
securely plugged in.

❏ Make sure that your outlet works and is not controlled by a
wall switch or timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the
printer and unplug it immediately. Then, check the printer labels.

If the voltage does not match, DO NOT PLUG YOUR PRINTER
BACK IN. Contact your dealer.

Only the power light is on

Try one or more of these solutions:

❏ Turn off the printer and computer. Make sure that the
printer’s interface cable is securely plugged in.
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❏ Make sure that there is no packing material in the printer.

❏ Turn off the printer and the computer and disconnect the
printer’s interface cable. Then, print an operation check page.
& “Running a printer operation check” on page 219.

If the check page prints correctly, make sure that the printer
software and your application are installed correctly.

❏ If you are trying to print a large image, your computer may
not have enough memory to print. Try printing a smaller
image.

❏ Windows Me, 98, and 95 users can clear any stalled print jobs
from the Spool Manager.
& “Using EPSON Spool Manager” on page 246.

❏ If you are using Windows NT 4.0, try uninstalling the EPSON
Printer Port. Click Start, point to Programs and then to
EPSON Printers, then click EPSON Printer Port Uninstall.
Follow the on-screen instructions.

❏ If the printer sounds like it is trying to print, but is unable to,
run the Head Cleaning utility.

If this does not work, replace the ink cartridges.
& See “Replacing Ink Cartridges” on page 197 for
instructions.

Error light is flashing or on

Check EPSON Status Monitor 3 (for Windows) or EPSON
StatusMonitor (for Macintosh) to find the cause of the error, then
try one or more of these solutions:

❏ If the b error light is on and paper is jammed in the printer,
remove the paper from the printer.
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❏ If the b error light is on and no paper is loaded, load more
paper in the sheet feeder.

❏ If the b error light is flashing, ink is low. Obtain a
replacement cartridge of the appropriate type. To determine
which cartridge is low, see “Replacing Ink Cartridges” on
page 197.

❏ If the b error light is on and ink is out, replace the
appropriate ink cartridge. To determine which ink cartridge
is empty, see “Replacing Ink Cartridges” on page 197.

Error light is on and power light is flashing

Follow the steps below.

1. Press the b maintenance button, then remove any paper in
the printer.

2. Turn the printer off. Check for and remove any foreign objects
or pieces of paper from inside the printer. Also, make sure
that there is sufficient space around the vent on the back of
the printer to allow proper ventilation. Remove any objects
blocking the vent. Then, turn the printer back on.

Note:
If you cannot remove a foreign object easily by yourself, do not use
force and do not disassemble the printer. Call your dealer for
assistance.

3. If the error does not clear, contact your dealer.
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Correcting USB Problems

If you are having difficulty using your printer with a USB
connection, see if your problem is listed below, and take any
recommended actions.

USB connections

USB cables or connections can sometimes be the source of USB
problems. Try one or both of these solutions:

❏ Use the USB cable (C83623✽) recommended in “System
Requirements” on page 271.

❏ For best results, you should connect the printer directly to the
computer’s USB port. If you must use multiple USB hubs, we
recommend that you connect the printer to the first-tier hub.

Windows operating system

Your computer must be a Windows Me, 98 or 2000 pre-installed
model, or a Windows 98 pre-installed model that was upgraded
to Windows Me. You may not be able to install or run the USB
printer driver on a computer that does not meet these
specifications, or that is not equipped with a built-in USB port.

For details about your computer, contact your dealer.

Printer software installation

Incorrect or incomplete software installation can lead to USB
problems. Take note of the following, and perform the
recommended checks to ensure proper installation.
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Checking printer software installation for Windows 2000 and
XP

When using Windows 2000 or XP, you must follow the steps in
the Setup sheet packed with the printer to install the printer
software. Otherwise, Microsoft’s Universal driver may be
installed instead. To check if the Universal driver has been
installed follow the steps below.

1. Open the Printers folder and right-click the icon for your
printer.

2. Click Printing Preference on the shortcut menu that appears,
then right-click anywhere in the driver.

If About is displayed in the shortcut menu that appears, click
it. If a message box with the words “Unidrv Printer Driver”
appears, you must reinstall the printer software as described
in the Setup sheet. If About is not displayed, the printer
software has been installed correctly.

Note:
If the Digital Signature Not Found (for Windows 2000 users) or
Software Installation (for Windows XP users) dialog box appears during
the installation process, click Yes (for Windows 2000 users) or
Continue Anyway (for Windows XP users). If you click No (for
Windows 2000 users) or STOP Installation (for Windows XP users),
you will have to install the printer software again.

Checking printer software for Windows Me and 98

If you canceled the plug-and-play driver installation in
Windows Me or 98 before the procedure was complete, the USB
printer device driver or the printer software may be incorrectly
installed. Follow the directions below to ensure that the driver
and printer software are installed correctly.
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Note:
The screens shown in this section are for Windows 98. Windows Me
screens may differ slightly.

1. Click the Start button, point to Settings, and click Printers.
Make sure that the icon for your printer appears in the Printers
window.

Select the icon for your printer, then click Properties on the
File menu.
241 Troubleshooting



12

12

12

12

12

12

12

12

12

12

12

12
2. Click the Details tab.

If EPUSBX: (EPSON Stylus Photo 830) is displayed in the
Print to the following port list box, then the USB printer device
driver and printer software is installed correctly. If the correct
port is not displayed, proceed to the next step.

3. Right-click the My Computer icon on your desktop, then click
Properties.

4. Click the Device Manager tab.
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If your drivers are correctly installed, EPSON USB Printer 
Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the Device
Manager menu, click the plus (+) sign beside Other devices
to view the installed devices.

If USB Printer or EPSON Stylus Photo 830 Series appears
under Other devices, the printer software is not installed
correctly. Proceed to step 5.

If neither USB Printer nor EPSON Stylus Photo 830 Series
appears under Other devices, click Refresh or unplug the
USB cable from the printer, then plug it into the printer again.
Once you’ve confirmed that these items appear, proceed to
step 5.
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5. Under Other devices, select USB Printer or EPSON Stylus 
Photo 830 Series and click Remove. Then, click OK.

When the following dialog box appears, click OK, then click OK
to close the System Properties dialog box.

6. Uninstall the printer software as explained in “Uninstalling
the printer driver” on page 210. Then turn off the printer,
restart your computer, and reinstall the printer software as
explained in the Setup sheet packed with your printer.
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Cancelling Printing

If you encounter problems while printing, you may need to cancel
printing. To cancel printing, follow the instructions in the
appropriate section below.

For Windows Me, 98 and 95 users

It is possible to cancel printing using either the Progress Meter or
EPSON Spool Manager. Refer to the appropriate section below.

Using the Progress Meter

When you send a print job to the printer, the Progress Meter
appears on your computer screen.

Click Stop to cancel printing.
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Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If
it receives two or more print jobs at one time, it holds them in the
order that they were received (with printers on a network this
may be called a print queue). When a print job reaches the top of
the line, the EPSON Spool Manager sends the job to the printer.
From the Spool Manager, you can cancel print jobs. You can also
view print status information about the print jobs which have
been sent to your printer, as well as pause and resume selected
print jobs.

After you send a print job, an EPSON Stylus Photo 830 Series
button appears on the taskbar. Click this button to open the
EPSON Spool Manager.

To cancel a print job, select the job in the list, then click Cancel.
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For users of Windows 2000, XP and NT 4.0

When you send a print job to the printer, the Progress Meter
appears on your computer screen.

Click Stop to cancel printing.

For Macintosh users

The procedure for canceling printing for Macintosh varies
depending upon whether background printing is on or off. Refer
to the appropriate section below.

For users of Mac OS 8.1 or later (except Mac OS X)

When background printing is on

Follow the steps below to cancel a print job.
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1. Select EPSON Monitor3 from the application menu.

2. Press the P power button to turn off the printer.

3. In the Document Name list, select the document which is
printing, then click the Delete icon button to cancel the
print job.

When background printing is off

Follow the steps below to cancel a print job.

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press
the period (.) key to cancel the print job.

For Mac OS X users

Follow the steps below to cancel a print job.
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1. Click the Print Center icon in Dock.

2. Press the P power button to turn off the printer.

3. In the Document Name list, select the document which is
printing, and then click Delete to cancel the print job.
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Chapter 13

Options and Consumable Products

Options

The following options are available for your printer.

Interface cables

EPSON supplies the following interface cables for your printer.
However, you can use any interface cable that meets these
specifications. See your computer manual for any additional
requirements.

❏ Parallel Interface Cable (shielded) C83602✽ from D-SUB
25-pin (computer) to 36-pin Amphenol 57 Series (printer)

❏ USB Interface Cable (shielded) C83623✽ from Series A 4-pin
(computer) to series B 4-pin (printer).

Note:
❏ The asterisk (✽) is a substitute for the last digit of the product

number, which varies by location.

❏ Depending on your geographic location, this cable may not be
supplied.

c Caution:
❏ Use only interface cables which meet the specifications listed

above. Using other cables not covered by EPSON warranties
may cause the printer to malfunction.

❏ To use your printer with a Hi-Speed USB 2.0 connection, be
sure to use a cable that is Hi-Speed USB 2.0 compliant.
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Consumable products

The following ink cartridges and EPSON special media are
available for your printer.

Ink cartridges

You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Media types

EPSON offers specially-designed media for ink jet printers to
meet most high-quality printing needs.

Black ink cartridge T026

Color ink cartridge T027
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Plain Paper

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

Product Name Uses Finish Serial
Number

EPSON Premium Ink Jet Plain
Paper (A4)

Reports, memos,
newsletters and
homework

Matte S041214

EPSON Bright White Ink Jet
Paper (A4)

Reports, memos,
newsletters and
homework

Matte S041442

Product Name Uses Finish Serial
Number

EPSON 360 dpi Ink Jet Paper
(A4)

Color e-mails,
letters, charts
and drafts

Matte S041059
S041025

EPSON 360 dpi Ink Jet Paper
(Letter)

Color e-mails,
letters, charts
and drafts

Matte S041060
S041028

EPSON Iron-On Cool Peel
Transfer Paper (A4)

Transfer photos
or graphics onto
fabric

Matte S041154

EPSON Iron-On Cool Peel
Transfer Paper (Letter)

Transfer photos
or graphics onto
fabric

Matte S041153
S041155

Product Name Uses Finish Serial
Number

EPSON Photo Quality Ink Jet
Paper (A4)

Presentations
and newsletters
with photos

Matte S041061
S041026

EPSON Photo Quality Ink Jet
Paper (Letter)

Presentations
and newsletters
with photos

Matte S041062
S041029
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EPSON Photo Quality Ink Jet
Paper (Legal)

Presentations
and newsletters
with photos

Matte S041067
S041048

EPSON Photo Quality Ink Jet
Card (A6)

Invitation cards,
digital photos,
fine arts

Matte S041054

EPSON Photo Quality Ink Jet
Card (5 × 8")

Invitation cards,
digital photos,
fine arts

Matte S041121

EPSON Photo Quality Ink Jet
Card (8 × 10")

Invitation cards,
digital photos,
fine arts

Matte S041122

EPSON Photo Quality Self
Adhesive Sheet (A4)

Posters and
children’s book
covers

Matte S041106

EPSON Ink Jet Note Cards A6
(with envelopes)

Invitation cards,
announcements
and notes with
photos

Matte S041147

EPSON Ink Jet Greeting Cards
5 × 8"
(with envelopes)

Invitation cards,
announcements
and notes with
photos

Matte S041148

EPSON Ink Jet Greeting Cards
8 × 10"
(with envelopes)

Invitation cards,
announcements
and notes with
photos

Matte S041149
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Matte Paper-Heavyweight

Photo Paper

Product Name Uses Finish Serial
Number

EPSON Matte
Paper-Heavyweight (A4)

Enlargements
and framing of
cherished
photos

Matte S041256
S041258
S041259

EPSON Matte
Paper-Heavyweight (Letter)

Enlargements
and framing of
cherished
photos

Matte S041257

EPSON Matte
Paper-Heavyweight (8 × 10")

Printing,
enlarging,
framing favorite
matte photos

Matte S041467

Double-Sided Matte Paper
(A4)

Newsletters,
brochures and
photographic
portfolios

Matte S041569
S041570

Double-Sided Matte Paper
(Letter)

Newsletters,
brochures and
photographic
portfolios

Matte S041568

Product Name Uses Finish Serial
Number

EPSON Photo Paper (A4) Reprints and
everyday photos

Glossy S041140

EPSON Photo Paper (Letter) Reprints and
everyday photos

Glossy S041141

EPSON Photo Paper (4 × 6") Reprints and
everyday photos

Glossy S041134

EPSON Photo Paper
(100 × 150 mm)

Reprints and
everyday photos

Glossy S041255
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EPSON Photo Paper
(200 × 300 mm)

Reprints and
everyday photos

Glossy S041254

EPSON Panoramic PhotoPaper
(210 × 594 mm)

Create photos,
banners and
panoramic
enlargementsfor
home or studio

Glossy S041145

EPSON Photo Paper Cards (A4) 8 pre cut
business sized
cards on A4
photo finish
card. For one off
run of business
cards or
alternative
business cards or
passes.

Glossy S041177

EPSON Photo Paper (4 × 6")
(No Perforation)

Borderless
photos with no
perforated
edges

Glossy S041458

EPSON Economy Paper (A4) Digital photo
printing

Glossy S041579
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Premium Glossy Photo Paper

Photo Quality Glossy Film

Product Name Uses Finish Serial
Number

EPSON Premium Glossy Photo
Paper (A4)

Enlargements
and framing of
cherished
photos

High
Gloss

S041287
S041297
S041285

EPSON Premium Glossy Photo
Paper (A4)

High quality
photos for glass
frames, photo
albums and
enlargements

High
Gloss

S041624

EPSON Premium Glossy Photo
Paper (Letter)

Enlargements
and framing of
cherished
photos

High
Gloss

S041286

EPSON Premium Glossy Photo
Paper (5 × 7")

Enlargements
and framing of
cherished
photos

High
Gloss

S041464

EPSON Premium Glossy Photo
Paper (8 × 10")

Digital photo
enlargements

High
Gloss

S041465

EPSON Premium Semigloss
Photo Paper (A4)

Create brilliant
pictures

Semigl
oss

S041332

EPSON Premium Semigloss
Photo Paper (Letter)

Create brilliant
pictures

Semigl
oss

S041331

EPSON Premium Luster Photo
Paper (A4)

Create brilliant
pictures

Semigl
oss

S041602

EPSON Premium Luster Photo
Paper (Letter)

Create brilliant
pictures

Semigl
oss

S041405

Product Name Uses Finish Serial
Number

EPSON Photo Quality Glossy
Film (A4)

Report covers
with photos

High
Gloss

S041071
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EPSON Photo Quality Glossy
Film (Letter)

Report covers,
color proofs,
certificates and
scanned images

High
Gloss

S041072

EPSON Photo Quality Glossy
Film (A6)

Report covers,
color proofs,
certificates and
scanned images

High
Gloss

S041107

EPSON Photo Stickers 16 (A6) Create stickers
usingphotos and
graphics

Glossy S041144

EPSON Photo Stickers 4 (A6) Create stickers
usingphotos and
graphics

Glossy S041176
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Ink Jet Transparencies

ColorLife Photo Paper

Note:
The availability of special media varies by location. For the latest
information on media available in your area, contact EPSON customer
services. See “Contacting Customer Support” on page 275 for details.

Product Name Uses Finish Serial
Number

EPSON Ink Jet Transparencies
(A4)

Report covers,
overlays and
overheads

Finish
n/a

S041063

EPSON Ink Jet Transparencies
(Letter)

Report covers,
overlays and
overheads

Finish
n/a

S041064

Product Name Uses Finish Serial
Number

EPSON ColorLife Photo Paper
(A4)

Long lasting
enlargements
and reprints

Semigl
oss

S041560

EPSON ColorLife Photo Paper
(Letter)

Long lasting
enlargements
and reprints

Semigl
oss

S041500
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Appendix A

Printer Specifications

Printing

Paper

Note:
Since the quality of any particular brand or type of paper may be changed
by the manufacturer at any time, EPSON cannot attest to the quality of
any non-EPSON brand or type of paper. Always test samples of paper
stock before purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 48 nozzles

Color (cyan, magenta, yellow, light cyan,
light magenta) 240 nozzles
(48 [each color] × 5)

Resolution Maximum 2880 dpi × 720 dpi

Control code ESC/P Raster

EPSON Remote

Print direction Bidirectional with logic seeking

Input buffer 32 KB
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Paper specifications

Single sheets:

Envelopes:

Size A4 (210 mm × 297 mm)

A5 (148 mm × 210 mm)

A6 (105 mm × 148 mm)

Letter (216 mm × 279 mm)

Half letter (139.7 mm × 215.9 mm)

Legal (216 mm × 356 mm)

Executive (184.2 mm × 266.7 mm)

5 × 7” (127 mm × 178 mm)

Paper types Plain bond paper, special paper
distributed by EPSON

Thickness
(for plain bond
paper)

0.08 mm to 0.11 mm (0.003 to 0.004 inch)

Weight
(for plain bond
paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)

Size No. 10 (104.8 mm × 241 mm)

DL (110 mm × 220 mm)

C6 (114 mm × 162 mm)

132 mm × 220 mm

Paper types Plain bond paper, air mail

Thickness 0.16 mm to 0.52 mm (0.006 to 0.02 inch)

Weight 45 g/m² (12 lb) to 75 g/m² (20 lb)
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Index Cards:

Iron-On Cool Peel Transfer Paper:

Transparencies, Photo Quality Glossy Film:

Self Adhesive Sheets:

Size A6 (105 mm × 148 mm)

5 × 8” (127 mm × 203 mm)

8 × 10” (203 mm × 254 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

A6 (105 mm × 148 mm) for glossy film

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Paper types Special paper distributed by EPSON
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Photo Paper:

Premium Glossy Photo Paper:

Premium Semigloss Photo Paper:

Premium Luster Photo Paper:

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Panorama (210 mm × 594 mm)

4 × 6” (114 mm × 175 mm)

4 × 6” (102 mm × 152 mm) No
perforations

100 mm × 150 mm

200 mm × 300 mm

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

5 × 7” (127 mm × 178 mm)

8 × 10” (203 mm × 254 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON
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ColorLife Photo Paper:

Photo Stickers:

Matte Paper-Heavyweight:

Double-Sided Matte Paper:

Note:
❏ Poor quality paper may reduce print quality and cause paper jams

or other problems. If you encounter problems, switch to a higher
grade of paper.

❏ Do not load curled or folded paper.

❏ Use paper under normal conditions:
Temperature 15 to 25°C (59 to 77°F)
Humidity 40 to 60% RH

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON

Size A6 (105 mm × 148 mm) with 4 or 16
frames

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON

Size A4 (210 mm × 297 mm)

Letter (216 mm × 279 mm)

Paper types Special paper distributed by EPSON
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❏ EPSON Photo Quality Glossy Film and Self Adhesive Sheets should
be stored under the following conditions:
Temperature 15 to 30°C (59 to 86°F)
Humidity 20 to 60% RH

Printable area

Single sheets (including panoramic size) and index cards

Envelopes

Normal No Margins ✽✽

Diagonal lines show printable area.

A

B-L B-R

C

A

B-L B-R

C
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Note:
Always load paper into the sheet feeder short edge first. Load
envelopes flap edge first with the flap side down.

A: The minimum top margin is 3.0 mm (0.12").

When loading multiple sheets of EPSON Photo
Quality Glossy Film, the minimum top margin is
30.0 mm (1.2").

B-L: The minimum left margin is 3.0 mm (0.12").

B-R: The minimum right margin is as follows:
3.0 mm (0.12") for single sheets and C6 envelopes.
7.0 mm (0.28") for DL envelopes.
28.0 mm (1.10") for No. 10 envelopes.

C: The minimum bottom margin is 14.0 mm (0.55").

✽: You can extend the minimum bottom margin to
3 mm by selecting the Minimize Margins check box
under More Options on the printer driver's Page
Layout menu (Windows) or the Maximum option
for Printable Area in the Page Setup dialog box
(Macintosh). However, print quality may decline in
the expanded area. Before printing large jobs using
this setting, print a single sheet to confirm printout
quality.

✽✽: When printing with the no margins feature, print
quality may decline in the top and bottom areas of
the printout, or the area may be smeared.
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Ink Cartridges

Black ink cartridge (T026)

Color Black

Print capacity* 540 pages, comparable with 3.5% ECMA
(ISO10561) at 360 dpi, 190 pages, 5% in
calculation

Cartridge life 2 years from production date
(within 6 months after opening package, at
25°C [77°F])

Temperature Storage:
-20 to 40°C (-4 to 104°F)

1 month at 40°C (104°F)

Transit:
-30 to 60°C (-22 to 140°F)

1 month at 40°C (104°F)

120 hours at 60°C (140°F)

Freezing:**
-16°C (3.2°F)

Dimensions 20.1 mm (W) × 66.85 mm (D) × 38.5 mm (
H)
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Color ink cartridge (T027)

* The figure given is based upon continuous printing after ink cartridge
replacement. The actual print capacity may vary, depending on how often
you use the print head cleaning function and how often you turn the printer
on.

** Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

Color Cyan, Yellow, Magenta, Light Cyan, and
Light Magenta

Print capacity* 220 pages/A4 (360dpi, 5% duty each color)

Cartridge life 2 years from production date
(within 6 months of opening the package at
25°C [77°F])

Temperature Storage:
-20 to 40°C (-4 to 104°F)

1 month at 40°C (104°F)

Transit:
-30 to 60°C (-22 to 140°F)

1 month at 40°C (104°F)

120 hours at 60°C (140°F)

Freezing:**

-18°C (-0.4°F)

Dimensions 49.1 mm (W) × 66.85 mm (D) × 38.5 mm (
H)
267 Printer Specifications



A

A

A

A

A

A

A

A

A

A

A

A

 

c Caution:
❏ EPSON recommends the use of original EPSON ink

cartridges only. Other products not manufactured by
EPSON may cause damage to your printer not covered by
EPSON's warranties.

❏ Do not use an ink cartridge if the date on the package has
expired.

❏ Do not refill the ink cartridges. The printer calculates the
amount of ink remaining using an IC chip on the ink
cartridge. Even if the cartridge is refilled, the amount of ink
remaining will not be recalculated by the IC chip and the
amount of ink available for use will not change.

Mechanical

Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder capacity About 100 sheets at 65 g/m² (17 lb) paper

Dimensions Storage

Width: 477.3 mm (18.8 inches)

Depth: 258.4 mm (10.2 inches)

Height: 181.2 mm (7.1 inches)

Printing

Width: 477.3 mm (18.9 inches)

Depth: 475.7 mm (18.7 inches)

Height: 269.0 mm (10.6 inches)

Weight 3.42 kg (7.5 lb) without the ink cartridges
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Electrical

Note:
Check the label on the back of the printer for the voltage of your printer.

Input voltage
range

90 to 264 V

Rated frequency
range

50 to 60 Hz

Input frequency
range

49.5 to 60.5 Hz

Rated current 0.2 to 0.4 A

Power
consumption

Approx. 18 W (ISO10561 Letter pattern)
Approx. 4 W in standby mode
Approx. 0.6 W in power-off mode
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Environmental

* Stored in a shipping container

** Without condensation

Standards and Approvals

U.S. model:

European model:

Temperature Operation:
10 to 35°C (50 to 95°F)

Storage:
-20 to 40°C (-4 to 104°F)

1 month at 40°C (104°F)

Transit:*
-20 to 60°C (-4 to 140°F)

120 hours at 60°C (140°F)

Humidity Operation:
20 to 80% RH

Storage:*,**
5 to 85% RH

Safety UL 1950
CSA C22.2 No.950

EMC FCC part 15 Subpart B class B

CSA C108.8 Class B

Low Voltage Directive 73/23/EEC EN 60950
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Australian model:

System Requirements

Refer to the appropriate section below for the minimum and
recommended computer system requirements necessary to use
this printer.

For Windows computers

To use your printer, you need Microsoft® Windows® Millennium
Edition, Windows® 98, Windows® 95, Windows® XP,
Windows® 2000 or Windows NT® 4.0 installed and the printer
must be connected via a shielded, twisted-pair parallel cable. If
you want to connect your printer to a USB port, you need a
Windows 98 or Windows 2000 pre-installed PC equipped with a
USB port and the printer must be connected via a standard,
shielded USB 1.1 cable. To use the USB 2.0 cable, you need a
Windows XP or 2000 Pre-installed PC equipped with a USB 2.0
port.

Your computer should also meet the following system
requirements.

EMC Directive 89/336/EEC EN 55022 Class B

EN 55024

EN 61000-3-2

EN 61000-3-3

EMC AS/NZS 3548 Class B

Minimum System Requirements Recommended System
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Your computer dealer can help you update your system if it does
not meet these requirements.

For Macintosh computers

To connect this printer to Apple® Macintosh® computers, you
must use a USB cable.

Pentium 150 MHz processor for
Windows Me

Pentium processor for Windows 98, 95
and NT 4.0

Pentium 133 MHz processor for
Windows 2000

Pentium 233 MHz processor for
Windows XP

Pentium 150 MHz or higher
processor for Windows Me

Pentium or higher processor
for Windows 98 and 95

Pentium 133 MHz or higher
processor for Windows 2000

Pentium II 300 MHz or higher
processor for Windows NT 4.0

300 MHz or higher processor
for Windows XP

32 MB RAM for Windows Me

16 MB RAM for Windows 98, 95 and
NT 4.0

64 MB RAM for Windows 2000

64 MB RAM for Windows XP

64 MB RAM or more for
Windows Me, 98, 95, 2000 and
NT 4.0

128 MB or more for
Windows XP

20 MB hard disk space for Windows Me,
98 and 95

40 MBhard disk space forWindows 2000
and NT 4.0

50 MB hard disk space for Windows XP

50 MB hard disk space or more
for Windows Me, 98 and 95

100 MB hard disk space or
more for Windows 2000, XP
and NT 4.0

VGA monitor for Windows Me, 98, 95,
2000 and NT 4.0

SVGA monitor for Windows XP

VGA or better monitor for
Windows Me, 98, 95, 2000 and
NT 4.0

SVGA or better monitor for
Windows XP
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Your Macintosh must also meet the following system
requirements.

Note:
❏ For users of Mac OS 8.1 or later (except Mac OS X), the amount of

available memory varies according to the number and kind of
applications that are open. To see how much memory is available,
choose About This Computer from the Apple menu, and refer to
the memory size (listed in kilobytes) under “Largest Unused Block”
(1,024K=1 MB).

❏ For Mac OS X users, to see how much memory is available, choose
About This Mac from the Apple menu.

❏ For users of Mac OS 8.1 or later (except Mac OS X), the memory
requirements above are for printing on Letter size paper. These
requirements may vary depending on the size of the paper, the type
of application you are using, and the complexity of the document
that you want to print.

Minimum System Requirements Recommended System

Mac OS 8.1 Mac OS 9.0 or later (except Mac OS
X)

14 MB of available memory

16 MB of available memory when
background printing is turned on.

29 MB of available memory or more

48 MB of available memory or more
when background printing is turned
on.

Minimum System Requirements Recommended System

Mac OS X 10.1.0 Mac OS X 10.1.2 or later

128 MB RAM 256 MB RAM or more
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In addition to these system and memory requirements, you need
15 MB of free hard disk space to install your printer software. To
print, you also need extra hard disk space amounting to about
twice the size of the file that you want to print.
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Appendix B

Customer Support

Technical Support Web Site

EPSON's Technical Support Web Site provides help with
problems that cannot be solved using the troubleshooting
information in your printer documentation. If you have a Web
browser and can connect to the Internet, access that site at:

http://support.epson.net/StylusPhoto830/

Contacting Customer Support

If your EPSON product is not operating properly and you cannot
solve the problem using the troubleshooting information in your
product documentation, contact customer support services for
assistance. If customer support for your area is not listed below,
contact the dealer where you purchased your product.

Customer support will be able to help you much more quickly if
you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product
software.)

❏ Brand and model of your computer
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❏ Your computer operating system name and version

❏ Names and versions of the software applications you
normally use with your product

For users in the United States and Canada

EPSON provides technical assistance 24 hours a day through the
electronic support services and automated telephone services
listed below. If you wish to speak directly to a technical support
representative, see your Printer Basics book for contact
information.

Note:
For help using any other software on your system, see the documentation
for that software for technical support information.

World Wide Web

From the Internet, you can reach EPSON Support at
http://support.epson.com. At this site, you can download
drivers and other files, look at documentation such as product
brochures and user manuals, and access troubleshooting
information.

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser (or
other software for FTP downloading) to log onto ftp.epson.com
with the user name anonymous and your e-mail address as the
password.

EPSON E-Mail Technical Support

To receive technical advice through e-mail, go to
http://support.epson.com and complete the form under the
troubleshooting tab, as requested.
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Automated Telephone Services

A variety of automated help services are available 24 hours a day,
seven days a week. To use these services, you must have a touch
tone telephone and call (800) 922-8911.

EPSON Accessories

You can purchase ink cartridges, paper, manuals, and accessories
from EPSON at (800) 873-7766 or visit our web site at
http://www.epsonstore.com (U.S. sales only). In Canada, please
call (800) 873-7766 for dealer referral.

For users in the United Kingdom and the Republic
of Ireland

http://www.epson.co.uk

Visit our Internet home page for a full list of support and warranty
services including:

❏ Register your product on-line

❏ Free access to the latest EPSON software drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help you quickly resolve
support issues

❏ Chat directly with a support technician on-line

❏ Email Technical Support
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Support Via Telephone

Pre-Sales Enquiries, Literature Requests and Nearest Dealer

For users in the Middle East

Some of these services may be available in English only.

http://www.epson.com

Select your country from our Internet home page for a full list of
support and warranty services including:

❏ Register your product on-line

❏ Free access to the latest EPSON software drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help you quickly resolve
support issues

UK 08705 133 640

The Republic of Ireland 01 679 9016

Home Page: http://www.epson.co.uk

Email: info@epson.co.uk

Telephone: UK 0800 220 546
The Republic of Ireland 1 800 409 132

Fax: UK 01442 227271
The Republic of Ireland 00 44 1442 227 271
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❏ Chat directly with a support technician on-line

❏ Email Technical Support

Technical Support Via Email and Telephone

Pre-Sales Enquiries, Literature Requests and Nearest Dealer

Select your country from our Internet home page at
http://www.epson.com.

For users in Scandinavia

Some of these services may be available in English only.

http://www.epson.com

Select your country from our Internet home page for a full list of
support and warranty services including:

❏ Register your product on-line

❏ Free access to the latest EPSON software drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help you quickly resolve
support issues

❏ Chat directly with a support technician on-line

Email: epson_support@compubase.co.ae

Telephone: +971 4 351 7777

Fax: +971 4 351 6617
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❏ Email Technical Support

Support Via Telephone

Pre-Sales Enquiries Literature Requests and Nearest Dealer

For users in South Africa

Some of these services may be available in English only.

Denmark 80 88 11 27

Finland 0800 523 010

Norway 800 11 828

Sweden 08 445 12 58

Denmark Home Page: http://www.epson.dk

Telephone: 38 48 71 37

Finland Home Page: http://www.epson.fi

Telephone: 0981 710 083

Norway Home Page: http://www.epson.no

Telephone: 231 62 124

Sweden Home Page: http://www.epson.se

Telephone: 08 519 92 082
Customer Support 280



http://www.epson.co.za

Visit our Internet home page for a full list of support and warranty
services including:

❏ Register your product on-line

❏ Free access to the latest EPSON software drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help you quickly resolve
support issues

❏ Chat directly with a support technician on-line

❏ Email Technical Support

Support Via Telephone

Pre-Sales Enquiries Literature Requests and Nearest Dealer

For users in Australia

EPSON Australia wishes to provide you with a high level of
customer service. In addition to your product documentation, we
provide the following sources for obtaining information:

Telephone: (011) 444-5223 or 0800 600 578

Home Page: http://www.epson.co.za

Telephone: (011) 448-2736 or 0800 005 956
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Your Dealer

Don’t forget that your dealer can often help identify and resolve
problems. The dealer should always be the first call for advise on
problems; they can often solve problems quickly and easily as
well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the EPSON Australia World Wide Web pages. Worth
taking your modem here for the occasional surf! The site provides
a download area for drivers, EPSON contact points, new product
information and technical support (e-mail).

EPSON Faxback Service

EPSON Faxback service will fax you the latest specifications for
most EPSON products offered in Australia. Phone (02) 9903 9075
and the system will guide you through a number of choices before
faxing the information to your fax machine.

EPSON Helpdesk

EPSON Helpdesk is provided as a final backup to make sure our
clients have access to advise. Operators on the Helpdesk can aid
you in installing, configuring and operating your EPSON
product. Our Pre-sales Helpdesk staff can provide literature on
new EPSON products and advise where the nearest dealer or
service agent is located. Many types of queries are answered here.

The Helpdesk numbers are:

Phone: 1300 361 054

Fax: (02) 9903 9189
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We encourage you to have all the relevant information on hand
when you ring. The more information you prepare, the faster we
can help solve the problem. This information includes your
EPSON product documentation, type of computer, operating
system, application programs, and any information you feel is
required.

For users in Singapore

Sources of information, support, and services available from
Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download,
Frequently Asked Questions (FAQ), Sales Enquiries, and
Technical Support via e-mail are available.

Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the
phone:

❏ Sales enquiries and product information

❏ Product usage questions or problem

❏ Enquiries on repair service and warranty

For users in Thailand

Contact for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download,
Frequently Asked Questions (FAQ), and e-mail are available.
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Epson Hotline (Phone: (66)2-670-0333)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problem

❏ Enquiries on repair service and warranty

For users in Indonesia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries,
questions through e-mail

Epson Hotline

❏ Sales enquiries and product information

❏ Technical support

Phone (62) 21-572 4350

Fax (62) 21-572 4357
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EPSON Support Center

For users in Hong Kong

To obtain technical support as well as other after-sales services,
users are welcome to contact EPSON Hong Kong Limited.

Internet Home Page

EPSON Hong Kong has established a local home page in both
Chinese and English on the Internet to provide users with the
following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

Jakarta Wisma Bisnis Indonesia 3rd floor
Jl. Letjen S.Parman Kav. 12,
Slipi-Jakarta
Phone/Fax: (62) 21-5357159

Bandung Lippo Center 8th floor
Jl. Gatot Subroto No.2
Bandung
Phone/Fax: (62) 22-7303766

Surabaya Gedung Koko Perdana 3rd floor
Jl. Jend. Basuki RakhmatNo. 105-107
Surabaya
Phone/Fax: (62) 31-5458562

Yogyakarta Hotel Natour Garuda
Jl. Malioboro No. 60
Yogyakarta
Phone: (62) 274-566353/22-143
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❏ Latest versions of EPSON product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Electronic Bulletin Board System

An electronic bulletin board system (BBS) is also available to
obtain product information and the latest versions of product
drivers. You can log on to the following number for the BBS
service:

Technical Support Hotline

You can also contact our technical staff at the following telephone
and fax numbers:

For users in Malaysia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.my)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries,
questions through e-mail

BBS: (852) 2827-4244

Phone: (852) 2585-4399

Fax: (852) 2827-4383
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Epson Trading (M) SDN. BHD

Head Office.

Epson Helpdesk

❏ Sales enquiries and product information (Infoline)

❏ Enquiries on repair services & warranty, product usage and
technical support (Techline)

For users in India

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download,
Frequently Asked Questions (FAQ), Products Enquiry, and
Technical Query are available.

Phone: 603-56288288

Fax: 603-56212088

Phone: 603-56288222

Phone: 603-56288333
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Epson India Head Office - Bangalore:

Epson India Regional Offices:

Help Desk

Nine City Help Line -9622 037766, available at Vadadora,
Bangalore, Chennai, Hyderabad, Cochin, Mumbai, Pune, Delhi
and Kolkata.

Phone: 5321 266-70

Fax: 5581799/5321095

Mumbai Phone: 8261516-17
Fax: 8257287

Delhi Phone: 6447201-06
Fax: 6447205

Chennai Phone: 8203940/41
Fax: 8272463

Kolkata Phone: 2871355/56
Fax: 2871357

Hyderabad Phone: 6329335/36

Cochin Phone: 361638/362677
Fax: 352940

Pune Phone: 4335460-ext 214
Fax: 4330881

Ahmedabad Phone: 6407176/77
Customer Support 288



For users in the Philippines

To obtain technical support as well as other after sales services,
users are welcome to contact the EPSON Philippines Corporation
at the telephone and fax numbers and e-mail address below:

World Wide Web (http://www.epson.com.ph)

Information on product specifications, drivers for download,
Frequently Asked Questions (FAQ), and E-mail Enquiries are
available.

Epson Helpdesk (Phone: (63) 2-813-6567)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Phone: (63) 2-813-6567

Fax: (63) 2-813-6545

E-mail: customersupport@epc.epson.com.ph
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Glossary

The following definitions apply specifically to printers.

application
Software that helps you carry out a particular task, such as word processing or
financial planning.

ASCII
American Standard Code for Information Interchange. A standardized coding
system for assigning numerical codes to letters and symbols.

banding
The horizontal lines that sometimes appear when printing graphics. This occurs
when the print head is misaligned. See also MicroWeave.

bit
A binary digit (0 or 1), which is the smallest unit of information used by a printer
or computer.

brightness
The lightness or darkness of an image.

buffer
The portion of the printer's memory used to store data before printing it.

byte
A unit of information consisting of eight bits.

characters per inch (cpi)
A measure of the size of text characters, sometimes referred to as pitch.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to
create the subtractive system array of printed colors.

color matching
A method of processing color data so that colors displayed on a computer screen
closely match colors in printouts. A variety of color-matching software is
available.
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ColorSync
Macintosh software that is designed to help you get WYSIWYG (what you see is
what you get) color output. This software prints colors as you see them on your
screen.

cpi
See characters per inch (cpi).

default
A value or setting that takes effect when the equipment is turned on, reset, or
initialized.

dithering
A halftoning method in which dots are arranged in an orderly pattern. Dithering
works best when printing images with solid colors, such as charts and graphs.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU
and allows direct communication between a computer and peripheral devices
(like printers), and between one peripheral device and another.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as a CD-ROM, hard disk, or floppy disk drive. In
Windows, a letter is assigned to each drive for easy management.

driver
Software that sends instructions to a computer peripheral to tell it what to do.
For example, your printer driver accepts print data from your word processor
application and sends instructions to the printer on how to print this data.
Together, the printer driver and printer utilities are referred to as "printer
software". See also printer software.

economy printing
Printing in which images are printed with fewer dots to save ink.

error diffusion
Error diffusion blends individual colored dots with the colors of the surrounding
dots to create the appearance of natural colors. By blending colored dots, the
printer can achieve excellent colors and subtle color gradation. This method is
best suited for printing documents that contain detailed graphics or photographic
images.
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ESC/P
Abbreviation for EPSON Standard Code for Printers, the system of commands
your computer uses to control your printer. It is standard for all EPSON printers
and is supported by most applications for personal computers.

ESC/P 2
The enhanced version of the ESC/P printer command language. Commands in
this language produce laser-like features, such as scalable fonts and enhanced
graphics printing.

Finest detail
This printer software setting automatically makes your printouts sharper and
clearer, especially for text. Be aware that this may increase the time required for
printing.

font
A style of type designated by a family name.

grayscale
A scale of shades of gray from black to white. Grayscale is used to represent colors
when printing with black ink only.

halftones
Patterns of black or colored dots used to reproduce an image.

high speed printing
Printing in which the print head prints images in both directions as it moves back
and forth. This provides faster printing.

ICM (Image Color Matching)
The color matching method used by Windows Me, 98, 95, and 2000 to match the
colors in your printout with the colors displayed on your screen.

initialization
Returns the printer to its defaults (fixed set of conditions). This happens every
time you turn on the printer or reset the printer.

ink cartridge
Contains the ink that your printer uses to print.

ink jet
A method of printing in which each letter or symbol is formed by precisely
spraying ink onto paper.
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interface
The connection between the computer and the printer. A parallel interface
transmits data one character or code at a time. A serial interface transmits data
one bit at a time.

interface cable
The cable that connects the computer to the printer.

local printer
The printer connected to the computer’s port directly by an interface cable.

media
Materials upon which data is printed, such as envelopes, plain paper, special
paper, and transparency film.

memory
The part of the printer’s electronic system that is used to store information (data).
Some information is fixed and is used to control how the printer operates.
Information that is sent to the printer from the computer is stored in memory
temporarily. See also RAM and ROM.

MicroWeave
Printing in which images are printed in finer increments to reduce the possibility
of banding and to produce laser-like images. See also banding.

monochrome
Printing which uses only one color of ink, usually black.

nozzles
Fine tubes in the print head through which ink is sprayed onto the page. Print
quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the printer. When you perform a printer
operation check, the printer prints the ROM version, code page, ink counter code,
and a nozzle check pattern.

parallel interface
See interface.

port
An interface channel through which data is transmitted between devices.

printable area
The area of a page on which the printer can print. It is smaller than the physical
size of the page due to margins.
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printer driver
See driver.

printer software
The printer software which comes with your printer includes a printer driver and
printer utilities. The printer driver lets you choose from a wide variety of settings
to get the best results from your printer. The printer utilities help you check the
printer and keep it in top operating condition. See also driver and utilities.

printer utilities
See utilities.

PRINT Image Matching
This system enables stunning printing to be achieved easily through the
combination of a digital camera loaded with the PRINT Image Matching function
and a printer that supports such matching. Print commands are attached to photo
data during digital camera photography and the printer adheres to these
commands to print photos with the color match that optimally fulfills the
objectives of the digitally composed shots.

print queue
When your printer is connected to a network, a waiting line in which print jobs
that are sent to the printer while it is busy are stored until they can be printed.

RAM
Random Access Memory. The portion of the printer's memory used as a buffer
and for storing user-defined characters. All data stored in RAM is lost when the
printer is turned off.

reset
To return a printer to its defaults by turning the printer off and then back on.

resolution
The number of dots per inch used to represent an image.

ROM
Read Only Memory. A portion of memory that can only be read and cannot be
used for data storage. ROM retains its contents when you turn off the printer.

RGB
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube
(CRT) monitor's electron gun, are used to create the additive array of screen
colors.

serial interface
See interface.
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spool
The first step in printing, in which the printer software converts the print data
into codes that your printer understands. This data is then sent directly to the
printer or to the print server.

spool manager
The software that converts print data into codes that your printer understands.
See also spool.

sRGB
The color management method used to maintain color consistency between
devices which adhere to the sRGB standard.

Status Monitor
The software that allows you to check the printer’s status.

subtractive colors
Colors produced by pigments that absorb some colors of light and reflect others.
See also CMYK.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral
devices (such as keyboards, mice, and printers) to the computer through a single,
general-purpose port. The use of USB hubs allows you to add additional ports.
See also interface.

utilities
Software that allows you to monitor and maintain your printer. Together, utilities
and the printer driver are referred to as "printer software". See also printer
software.

WYSIWYG
What-you-see-is-what-you-get. This term is used to describe printout that looks
exactly like it appears on screen.
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